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COPYRIGHT NOTICE

WinRamp Lite and this manual are Copyright (c) 1994 by Vironix N.A., Inc.

No parts of  WinRamp Lite or this manual may be reproduced in part or in whole, except as
provided in the License Agreement in the following pages.

DISCLAIMER

Vironix N.A., Inc. makes no warranty of any kind, either express or implied, including but not
limited to implied warranties of merchantability and fitness for a particular purpose, with respect
to this software and accompanying documentation.

IN  NO  EVENT  SHALL VIRONIX  N.A.  INC.  BE  LIABLE  FOR  ANY DAMAGES  (INCLUDING
DAMAGES FOR LOSS OF BUSINESS PROFITS, BUSINESS INTERRUPTION, LOSS OF BUSINESS
INFORMATION, OR OTHER PECUNIARY LOSS) ARISING OUT OF THE USE OF OR INABILITY
TO  USE  THIS  PROGRAM,  EVEN  IF  VIRONIX  N.A.,  INC.  HAS  BEEN  ADVISED  OF  THE
POSSIBILITY OF SUCH DAMAGES.

TRADEMARKS

WinRamp is a trademark of Vironix N.A., Inc.

Any product or brand names mentioned in this manual are trademarks or registered trademarks of
their respective owners.

LICENCE AGREEMENT

Please  carefully  read  the  following  terms  and  conditions.  Continued  use  of  WinRamp  Lite
constitutes your acceptance of these terms and conditions and your agreement to abide by them. 

WinRamp Lite is a "shareware program" and is provided at no charge to the user for an evaluation
period of 30 days. If you find this program useful and find that you are using WinRamp Lite after
the  30  day  evaluation  period,  please  register  the  product  (see  registration  details  below).
WinRamp Lite may not be modified in any way, and should be distributed with all supplied files
in its orginal archive format: WRAMP12.ZIP or RAMP12.ZIP (on CIS)

The 30-Day Free Evaluation Licence  is a legal agreement between you, the end user, and Vironix
N.A., Inc. By using WinRamp Lite, you are agreeing to be bound by the terms of this Agreement.
If you do not agree to the terms of this Agreement please discontinue using WinRamp Lite.
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Business & Government Site Licence
After the 30 day Evaluation Period, any corporation, institution, government agency or business
wishing to continue use of  WinRamp Lite in the course of its internal business is required to
purchase a  WinRamp Lite registration or site licence. Any individual wishing to use  WinRamp
Lite within a corporation, institution, government agency or business must purchase a WinRamp
Lite registration or site licence. The site licence is provided for those who want to WinRamp Lite
on multiple computers. Please see the REGISTER.WRI or contact Vironix N.A., Inc. for terms.

Upgrade Policy
Registered users of WinRamp Lite will automatically be sent a diskette (no printed manual) of the
next MAJOR release (for example 1.x to 2.0 etc.) of WinRamp Lite at NO CHARGE. Registration
serial  numbers  will  expire  after  the  SECOND  major  release  (for  example  1.x  to  3.x  etc.).
Thereafter a discounted upgrade fee will apply to further major upgrade releases.

Users  wishing to  receive MINOR upgrade diskette  sets  (for  example 1.1 to 1.2 etc.)  will  be
charged only for the diskette and mailing.  Registered users can apply their  registration serial
numbers to MINOR upgrade releases downloaded from the WinRamp Lite Support BBS or any
online system where the shareware distribution archive can be found. 

VIRONIX’S SHAREWARE DISTRIBUTION POLICY 

The essence of shareware software is to provide users with an opportunity to evaluate quality
software before buying it, thereby keeping prices low while still providing developers with an
incentive to continue development. Shareware is a distribution method, not a type of software.
Copyright laws apply to registered Shareware just the same as they do for commercial software.

WinRamp Lite as Shareware
WinRamp Lite is  distributed under  the  "Try Before  You Buy"  Shareware marketing concept.
WinRamp Lite is a FULLY FUNCTIONAL communications program and no features, commands
or functions have been disabled or crippled in any way. WinRamp Lite is NOT free software, and
we  strongly  encourage  you  to  register  your  copy.  With  registration  you  will  be  entitled  to
numerous special benefits, including:

· the latest version of the software
· an optional printed manual
· one FREE major version upgrade
· full access to the WinRamp Lite Support BBS
· a full rebate of the registration fee when purchasing the commercial version of WinRamp 

directly from Vironix N.A., Inc.

Dual Channel Distribution Policy
A number  of  Shareware  publishers,  having  attained  a  reasonable  degree  of  success,  have
"graduated" away from the Shareware marketing and distribution concept, often citing the low
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rate of user registration as an obstacle to economic growth. Despite the obvious economic risks of
publishing quality software under the Shareware concept, and due mainly to a strong belief in the
future and sheer power of the "super data-highway" as a medium for publishing and distributing
software,  Vironix N.A. has deliberately embraced a Dual Channel distribution policy. 

Page 4



The elements of this Dual Channel distribution policy are: 

1. To publish and distribute a fully functional application capable of competing (and beating)
feature-for-feature with commercial/retail  packages often costing FOUR times as much as
WinRamp Lite. It is Vironix NA's policy to continue development and upgrading of WinRamp
Lite in parallel to development of an even more powerful commercial product: WinRampTM,
and to continue to commit to distributing WinRamp Lite as shareware.

2. To publish and market through standard retail channels a fully integrated, fully customisable
communications  environment,  namely  WinRamp with  superior  features  -  whilst  offering
registrants of the shareware  WinRamp Lite a FULL REBATE of their registration fee when
purchasing WinRamp directly from Vironix NA, Inc.

How this policy benefits you

Vironix NA's Dual Channel distribution policy directly benefits you, the end-user, as you are able
to  fully  evaluate  WinRamp Lite BEFORE spending a  cent.  Furthermore  should  you  wish  to
upgrade to WinRamp, you will have TWO full products for the price of one.

REGISTRATION

Registering  WinRamp Lite licenses you to use the product after the 30 day evaluation period.
Registered users of  WinRamp Lite  will receive the latest version of the product,  with a serial
number,  technical  support  and a bound user manual.  A two-tiered pricing structure exists  for
registration: $35 (US) for a licensed copy of WinRamp Lite, free technical support and manual on
disk; or $45 (US) which includes a licensed copy of WinRamp Lite, free technical support and a
printed and bound manual. Bulk purchases are subject to discount. Please call our toll free sales
number for details.

Prices and terms are subject to change without notice.
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Methods of ordering:

1. Call direct to 1-800-VIRONIX   (VISA, Mastercard) 
(USA & Canada only) 

2. Fax order form: to 508-354-8559        

3. Compuserve
GO SWREG ID#: 3034 

4. Vironix NA Support BBS   - Dial 508-374-7125 

5. Send cheque or postal order to
Vironix N.A., Inc.     
P.O. Box 1570 
Haverhill
MA 01831-998 

WinRamp Lite may be purchased directly from the following International Distributors:

 South Africa and Southern African countries:

      Vironix Corporation (Pty). Ltd.
      Suite 4: Buckhurst, Essex Gardens 
      Durban, 3630
      Rep. of South Africa         Tel:  +27 31 266-8930

Fax or Post Order Form
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             WinRamp Lite Order Form

Name: _______________________________________________

Company: _______________________________________________

Address : _______________________________________________

_______________________________________________

_______________________________________________

Telephone number: ______________________

Fax number: ______________________

E-mail address: ______________________
 
Item        Unit  Price       Qty        TOTAL

WinRamp Lite Basic Registration...................   $35.00        ___    $________
WinRamp Lite Registration with Manual..........  $45.00          ___    $________
Add $1 per copy for 3.5" disks      $________
Shipping/Handling - USA/Canada $10.00      $________
Shipping/Handling - Outside USA $15.00      $________
Add applicable State & County Sales Tax                    $________

Total in US Funds drawn on a US Bank      $________
(Check, money order, or credit card payments accepted).

For Credit Card Users Only:
Type of credit card    [ ] VISA     [ ] MasterCard     [ ] American Express

Card number: _________________________________

Name (as it appears in card): _________________________________

Expiration date of card: ____/____/____

Signature: _________________________________

Where did you hear about or obtain WinRamp Lite from?
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___________________________________________________________________________

___________________________________________________________________________

WHAT HAPPENS AFTER REGISTRATION

After you have registered WinRamp Lite, the following will occur:

1. Upon  bank  clearance  of  your  registration  fee  (or  credit  card  verification),  you  will
immediately be issued with TEMPORARY Registration Serial  Number  Key,  which when
typed at the  Registration dialog will prevent any further "nagscreens" from appearing whilst
running WinRamp Lite.  

2. The next step depends on how you registered:

· If you have phoned through your credit card registration via one of the voice contact
numbers,  your temporary key will  be read to you over  the phone.  This is  subject  to  the
verification of your credit card.
· If  you have registered through the Automated Registration on the WinRamp Lite
Support BBS, you will also immediately be issued with a temporary key whilst online. 
· If you registered via email, a reply message will contain your temporary key.
· If you registered on CompuServe (GO SWREG ID:3034), your temporary key will
be sent to you via private CompuServe  email. 

3. A diskette set will immediately be posted to you, containing the full registered version of
WinRamp Lite, in addition to a permanent serial number. 

PRINTING THIS MANUAL

This manual has been prepared using the Microsoft Windows  Write  application. Applying the
following settings should ensure the manual prints correctly:
· Left and right margins set at 1.25" and top and bottom margins set at 1". These are set in

Page Layout, accessed from the Windows Write Document Menu. 
· All Tabs stops cleared. Check this by using the Tabs option under the  Document menu and

clicking the Clear All button.
· Printing page size set for letter 8 1/2 x 11, under Print Setup accessed from the File menu. 

Page breaks have been set for printing according to the above specifications. Should you choose
to  print  on  a  different  page  size,  formatting  of  the  document  will  be  misaligned,  and  page
numbering in the Table of Contents will be incorrect. However, if you do choose to print using a
different page size, it is recommended that you at least repaginate the document so that blank
pages are not printed. Use the Repaginate command from the Write File menu, with the Confirm
Page Breaks check box marked so that you can keep page breaks between chapters, but move the
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others to a more logical breaking point.  

Remember that if you would like a more comprehensive printed and bound manual - register
now!
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CHAPTER ONE:     INTRODUCTION

This chapter serves as a brief introduction to WinRamp Lite, providing some background you may
need about Microsoft Windows and communications in general. Advanced users may want to skip
directly to the section on hardware and software requirements for WinRamp Lite.

1.1 Welcome to WinRamp Lite!

WinRamp  Lite is  a  full-featured  communications  package  for  the  Microsoft  Windows
environment  that  allows  you  to  use  a  modem  to  communicate  with  the  millions  of  other
computers in the world, using the telephone system. WinRamp Lite is specially designed to make
communications simpler and more intuitive.

1.2 Some of the Advanced Features of WinRamp Lite

Some of the ADVANCED features of WinRamp Lite 1.2:

· RIPScrip graphical terminal emulation:
Use WinRamp Lite to access Bulletin Board Systems supporting the exciting new graphical
RIP  terminal  emulation.  Currently  WinRamp  Lite is  the  FIRST  and  ONLY shareware
Windows communications package supporting RIP. The WinRamp Lite RIP implementation
works under  Windows 16-color VGA*, in addition to the optimal 256-color (and more)
SuperVGA.

 * Note: RIPScrip was originally designed to run under the 64-color Borland BGI graphics 
drivers.

· Multiple font-sizes under ANSI and AVATAR terminal emulations:
With multiple font sizes under the popular ANSI BBS terminal emulation you are able to
optimise  your  terminal  emulations  to  run under  the  Windows resolution of  your  choice.
During  installation  WinRamp  Lite will  automatically  "sense"  your  Windows  graphics
resolution and  install the optimal.

· Prestel terminal emulation for Videotext based systems.
Access the public Videotext systems in a number of European and other countries around the
world (for example Britain, France, Israel and  Australia)

· Open multiple terminal emulation windows simultaneously:
A unique  feature  to  WinRamp  Lite is  your  ability  to  open  multiple  terminal  emulation
windows. It's possible to open an AVATAR window, an ANSI window and a RIP windows ..
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all  on  the  same  online  system,  or  even  different  systems  if  you  have  multiple  devices
installed.
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· Customizable floating toolbars:
Everyone  has  different  tastes  and  preferences.  The  WinRamp  Lite user  interface  is
remarkably customizable. Use the Toolbar Editor to create your own custom toolbars, and
place these toolbars in the place of tour choice on the screen. WinRamp Lite is shipped with 3
default toolbars.

· Graphical and Text "Cut & Paste":
"Cut & Paste" to the Windows clipboard BOTH text and Windows graphics from terminal
emulations. This unique feature will enable you to quickly take rapid "screen shots" of your
favourite  online  systems and paste  the  resulting  Bitmap image  into  any other  Windows
application.

· Multiple Dialing Directors:
This unique feature allows you to maintain and open any number of Dialing Directories
(limited  only  by  your  hard-drive  and  RAM resources).  Directory  Entries  from multiple
directories  can be seamlessly "merged" by toggling the  WinRamp Lite Dialing Directory
Tabs.

· Hot Dial Window:
Set-up your favorite online systems to be included within the unique Hot Dial Window, each
with it's own special icon. A click on the system's icon and that system will automatically be
dialed ... no other keystrokes necessary!

· WR-Script:
A powerful, compilable yet easy to use scripting language.  Use the Auto-learn feature to
capture and playback your entire online session.

· Command Stack:
The Command Stack window facilitates type-ahead and is especially useful when using Chat
Mode and Multi-user Dungeons as it allows you to type in commands and store them to be 
executed in the terminal window at a later stage and as many times as you specify.

· WinRamp Dialing Directory Converter:
The WinRamp Dialing Directory Conversion Utility enables you to easily convert the dialing
directories you have created while using other communications packages into the WinRamp 
Lite dialing directory format.

Among  the  WinRamp  Lite "standard"  features  you'd  expect  to  find  in  a  high  quality
communications package:

· Macro Record and Playback. Automate functions that are often used.
· File Transfer Protocols. These include Kermit, Zmodem, Ymodem, Ymodem-G, 

Ymodem, Xmodem, Xmodem-CRC and Xmodem-1K.
· Capture terminal sessions to text file. Includes the ability to capture special emulation 

Page 15



"formatting" characters if so desired.
· Standards-compliant TTY, ANSI, Avatar, Prestel, VT52-220 and RIPScrip emulations.
· Unlimited dialing numbers per directory entry.
· Supports all 9 communications ports supported by Windows.
· Access Network drives directly from within WinRamp Lite.
· Scroll-Back buffer limited only by RAM. Full scroll-back buffer can be saved to a text 

file at any time.
· Comprehensive and easy-to-use Online Help, including a handy Index to make finding a 

topic just that much easier.
· GIF Viewer can be enabled during Y-, X-, and Z-Modem downloads.
· Customizable keystroke mappings.

1.3 Windows Basics 

Before you install and use WinRamp Lite there are certain Microsoft Windows conventions you
should be familiar with:

Mouse actions:
Click: Pressing the left button of the mouse once and immediately releasing it.
Double click: Pressing the left button of the mouse twice in quick succession.
Drag: Pressing and then holding down the left mouse button while moving the

mouse. to the required destination.

Windows:
Active window: The upper most window (with highlighted borders) that is currently being worked

with.
Scrolling: Scrolling  the  visible  portion  of  the  current  window vertically  or  horizontally

through mouse actions in the active window's scroll bars.
Moving: Clicking the active window's title bar and dragging it to a new location.
Resizing: Clicking anywhere on the active window's border and dragging the border to a

new position.
Closing: Double clicking on the icon at the top right of the active window.

Controls:
Dialog boxes: A form for updating and capturing information a program requires.
Radio buttons: Mutually exclusive selection indicators.
Check boxes: Toggle on or off.
List boxes: To select an option from a list.
Edit boxes: To enter requested information.

1.4 Communications Basics
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Communications sessions usually occur between your PC and a remote or host computer using a
hardware  device  called a  modem,  a  standard  telephone  line and  communications software
(WinRamp Lite).  The  communications  software is  installed on your  PC,  while  the  modem is
attached to your computer’s serial port and to a telephone line. The host or remote computer
typically has a number of modems attached to it, waiting to receive calls from users who wish to
make use of the services offered by the remote system. The basic steps that occur when you
communicate with a remote system are (details on each of these operations and how to perform
them are provided further on in this manual):

1. You use the communications software (WinRamp Lite) to dial a remote system. 
2. WinRamp Lite sends a dial command to the modem.
3. The modem waits for a dial tone on the phone line and dials the phone number.
4. WinRamp Lite  watches for result codes from the modem (see Appendix F).
5. The modem waits for the remote system’s modem to answer.
6. The remote system’s modem answers the call, signalling an answer tone along the phone line.
7. Your modem senses the answer tone and sends a carrier start signal.
8. Both modems agree on speed, modulation, error checking and data compression protocols.
9. Your modem sends a connect result code to your computer, turns the speaker off and turns the

Carrier Detect signal on.
10.WinRamp Lite detects the connect result code and Carrier Detect signal, and tells you the

connection has been successful.
11.WinRamp Lite manages your communication with the remote system.
12.Your modem and the remote system’s modem transmit data between each other.
13.When you have completed the communications session, you use WinRamp Lite to disconnect

from the remote system.
14.Your modem hangs up the telephone line, the remote modem detects this and also hangs up.

Don’t worry if some of the terminology used here is foreign to you, it will become clearer as you
read further in the manual and make practical use of WinRamp Lite. The glossary in Appendix A
will clarify terminology.  

1.5 Files included with   WinRamp Lite     

WINRAMP.EXE: The main program executable.
install.exe: Run this to install WinRamp Lite.
install.bin: File used by install.exe.
install.inf: Holds installation information.
install.txt: Installation notes.
upgrade.dll: WinRamp Lite support file.
bc40rtl.dll: WinRamp Lite support file.
owl100.dll: WinRamp Lite support file.
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owl31.dll: WinRamp Lite support file.
tclass40.dll: WinRamp Lite support file.
vctrl.dll: WinRamp Lite support file.
terminal.dll: Vironix-supplied terminal emulation module.
transfer.dll: Vironix-supplied transfer protocols module.
winramp.fon: Fonts required for Prestel and other emulations.
*.chr: Fonts for RIP emulation.
winramp.wri: This manual.
register.wri: A windows Write file containing registration details. 
winramp.hlp: Main WinRamp Lite help file.
register.hlp: Help file containing registration details.
ripicons.exe: Self-extracting archive containing RIP Icons. See install.txt.
venddat.wrb: Modem vendor settings database.
convert.exe: A DOS utility  for  converting dialing directories  to  the  WinRamp Lite
format. 
convert.wri: A  text  file  containing  WinRamp  Dialing  Directory  Converter
information.

1.6 System Requirements

· Hardware which will run Microsoft Windows 3.1, with at least 3.0 MB free disk space.
· Microsoft Windows 3.1 or higher..
· Communications hardware supported by Windows, such as the COM ports built into an IBM-

compatible PC.
· Optionally, a modem or other device which connects two computers (Recommended: V.32 bis

modem).

1.7 Conventions Used in this Manual

Menu options and commands and buttons are indicated with an arial font.  Bold is used to 
provide emphasis.

1.8 Technical Support

For registered users ONLY. When you register your copy of WinRamp Lite we will provide you
with our access number for voice and online technical support.
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CHAPTER TWO:     GETTING STARTED WITH WinRamp Lite
In this chapter, installation and start-up instructions are provided. For advanced users, there is a
quick start  guide.  This  is  followed by a  more detailed guide for  less  advanced users,  which
includes descriptions of what to expect when you first start WinRamp Lite.

2.1 Installing WinRamp Lite

1. If  you received  a  compressed  ZIP file,  extract  the  files  to  an  empty  directory:  Pkunzip
wramp120.zip. (or ramp12.zip if you downloaded the file from Compuserve)

2. Run the install program INSTALL.EXE. (File | Run in Program Manager).
3. The WinRamp Lite files will be copied to the directory of your choice and the correct fonts

will be installed.

If there is a file named README.TXT on the WinRamp Lite disk, or in the archive you received,
you should read the contents of the file before you install WinRamp Lite. Any instructions which
could not be included in this manual will be documented there.

2.2 Quick Start 

If  you  want  to  get  right  into  using  WinRamp  Lite,  then  start  Windows,  and  run  the
WINRAMP.EXE executable.  The  WinRamp Lite logo will  come up,  followed closely  by the
WinRamp Lite Quick Configuration dialog box.  You can now either use the Quick Configuration
facility or configure WinRamp Lite yourself.

2.2.1 Using the Quick Configuration Facility:

1. Click  the  Continue Quick Config  button in  the  WinRamp Lite Quick  Configuration
Window.

2. Select the Comm Port your modem is attached to and click the Next button.

3. Select your modem model from the Modem Selected list and click the Next button.

4. Select the Baud Rate of your modem and click the Next button.

5. Check the relevant boxes for the toolbars you would like displayed in the main window
of WinRamp Lite and click the Next button.
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6. Type the names of your Dialing Directory and the file it will be stored as and click the
Next button.

7. If you want the Dialing Directory window or the Hot Dial window open as WinRamp Lite
starts up, check the appropriate check box(es) and click the Next button.

8. Type in the name, and number of the BBS system you would like to set up and select the
protocol and terminal emulation it supports.  Click the Next button.

9. Check the configuratuion settings you have entered in the Quick Configuration Summary
window.  Make any necessary changes and click the Save Quick Config button.

10. You can go back to any previous Quick Configuration dialog box(es) at any time by
clicking the Back button.

11. Now you can dial the BBS you have set up by double-clicking the entry in the Dialing
Directory window or by double-clicking the icon for the BBS system in the Hot Dial
window.

2.2.2 Quick Start for Advanced Users

1. Click the Skip Quick Config button in the WinRamp Lite Quick Configuration window.

2. From the  Configure main menu option, select the  Device.  This configures  WinRamp
Lite for the equipment you have attached to your computer.

3. Click the  Add button, and select the correct settings for your device. {strings, vendor
modem}

4. Click on the OK button, followed by the Close button.

5. Now you can  open a  communications  session  by  selecting,  from the  Communicate
menu, the Dial option (or click the  button on the toolbar). Choose the device you wish
to use, followed by the terminal emulation, and then enter the telephone number if you
wish to have it dialled automatically.

You're on your way!

2.3 Starting WinRamp Lite

WinRamp  Lite is  started  simply  by  running  the  WINRAMP.EXE  executable  file.  Once  the
software is installed, this can be accomplished by double-clicking on the WinRamp Lite icon in
Windows' Program Manager. If the icon is not installed in Program Manager, use File Manager to
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change  to  the  directory  containing  the  WINRAMP.EXE file,  and  double-click  on  the  file  to
launch WinRamp Lite.
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2.4 Navigating around   WinRamp Lite  

WinRamp Lite should be as familiar as any other Windows application, the program has a main
window which has a menu, toolbars, and resizable borders. There are operations which open child
windows, namely opening a terminal session, and opening the dialing directory. On launching
WinRamp Lite, the following components will be visible - the menu bar, the toolbar, and a status
bar. These are explained next.

2.4.1 WinRamp Lite   Menus:  

WinRamp Lite has the following top level menus: File, Edit, Communicate, Configure, Scripts,
Register, Window and Help. Their uses are as follows (full descriptions of all menu commands
are provides under the reference section of this manual):

· File - contains operations applicable to individual files (uploading and downloading) as well
as the Exit option, to close WinRamp Lite.

· Edit - the "Cut & Paste" menu - operations which deal with text editing.

· Communicate - contains all the commands you'll require to communicate with a remote
system.

· Configure - allows the modification of the environment in which  WinRamp Lite operates,
including which devices are available, which emulations are available, etc.

· Scripts  - consists of options related to the recording, running and writing of scripts and
macros which enable you to automate WinRamp Lite.

· Window - controls the child windows of WinRamp Lite, resizing, closing, etc.

· Register - provides information about registering WinRamp Lite.

· Help - access the Windows Help system, with WinRamp Lite-specific help.

2.4.2 The Toolbars

There are four default  toolbars available when you first  install  WinRamp Lite: The Standard
toolbar giving easy access to the most common functions, the Configuration toolbar for set-up
and configuration functions,  the  Online Actions toolbar for  functions that  can be performed
during an open communication session and the Scripts and Macros toolbar containing functions
related to script and macro execution.  The Standard toolbar is the only toolbar which is actually
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displayed when WinRamp Lite is first started up. By placing your mouse over a button appearing
in the toolbar, you will notice a description of the function that button performs appearing below.
These are configurable and can be switched off once you are familiar with the functionality of the
buttons.  WinRamp  Lite has  extremely  sophisticated  toolbars,  designed  to  make  your
communications efforts as easy a possible. There is the option of having multiple toolbars, each
configurable as to which tools are on the toolbar, how the toolbars appear, and how they are
positioned (see 5.1 Toolbars for more details).

2.4.3 The Status Bar

This is the gray bar that appears along the bottom of the screen. It is used to display messages and
information about the current status of a particular action you may be performing with WinRamp
Lite. When you first load up WinRamp Lite  the status bar will be blank.

2.5  Exiting   WinRamp Lite  

To exit WinRamp Lite, use any of the following methods :

1. Click on the Exit button on the toolbar (the button with the red arrow pointing left).

2. Choose Exit from the File menu.

3. Double-click the horizontal bar in the top left corner of the WinRamp Lite window.

Next time you open WinRamp Lite, all the previous settings apply and any open windows will be
displayed.

2.6 Using Online Help

At any point while you are using  WinRamp Lite, you can obtain help by choosing one of the
topics under the Help menu. This will call up a hypertext help document which will guide you in
the use of  WinRamp Lite. Help can also be launched from any dialog box for context sensitive
help.

For help on how to use the Windows hypertext system, see the section on  How to Use Help,
from the Help menu. To find help on a specific topic, use the Search for Help on option from
the Help Menu.
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CHAPTER THREE:     STARTING A COMMUNICATIONS SESSION

Once you're familiar with the components of the opening screen of WinRamp Lite, the next thing
you'll  probably  want  to  do  is  communicate!  WinRamp  Lite offers  a  number  of  methods  to
communicate with a remote system (such as an Online Service or Bulletin Board System), each of
which is launched from the Communicate Menu item.

Choosing Open Terminal from the Communicate menu will open a terminal window without
prompting for dialing details. This allows you to dial a remote system manually, using the Hayes
AT commands (see Appendix E). If you know the number and basic configuration details of a
remote system, and you are unlikely to want to connect to the system again,  then choose Manual
Dial from the Communicate menu option and perform the following simple three step operation:
select a device (typically a modem) to use; select an emulation, and enter a telephone number for
the  remote  system.  It  is  then  simply  a  case  of  dialing,  or  starting  a  connection  for  the
communications session. 

Alternatively, if you are likely to use the remote system more frequently, you can set it up as an
entry in the dialing directory and dial the system from there. Another option is for those systems
you use a lot.  WinRamp Lite has a special "Hot Dial" facility for these systems, where a simple
double click on the icon representing one of your favorite systems will cause  WinRamp Lite to
start dialing it.  Note that multiple communications sessions can be run simultaneously. 

Each of these communication methods will  be described in more detail  further on.  However,
before  you  attempt  to  start  a  communications  session,  you  must  configure  certain
communications  options.  The most  important  of  these  is  to  tell  WinRamp Lite  which device
(modem)  you  are  using.  Other  options  are  defining  terminal  emulations  and  protocols  (for
descriptions of terminology you may be unfamiliar with, refer to the glossary in Appendix A of
this manual) you wish to use with systems you may be dialing. Defaults for those terminals and
protocols supported by WinRamp Lite have already been set-up, so you don't have to worry about
configuring these at this stage (refer to Chapter 5 for details on how to configure these options).
However, it is critical that you ensure the modem you have attached to your computer is specified
correctly:

3.1 Defining Devices

Defining a  device involves  telling  WinRamp Lite what  sort  of  equipment is  attached to your
computer, to enable it to connect to other computers. Basically, which modem you have plugged
in!

In order for WinRamp Lite to automate as much of the connection to a remote system as possible,
you need to tell  it  what  sort of hardware you have on your computer.  This involves the line
parameters the computer must  use to send data to the modem, and the commands which the
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modem requires to set it up for operation. Don't worry if you don't know these details, WinRamp
Lite automates much of this set-up. 

To define the device or devices (if you are likely to use more than one type of modem ), choose
the Device option from the Configure menu item. The Device Configuration dialog box will be 
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displayed, containing a number of default modem settings. We recommend you use a Hayes AT
Command Set compatible modem. Virtually all   modern modems are of this kind. If you are
unsure  whether  your  modem is  Hayes  compatible  or  not,  you generally  won't  go  wrong by
assuming that it is. 

The following device options are available:

3.1.1 Adding a Device

To add a device, click the Add button, and you will be presented with a dialog box detailing the
modifiable options for a device. If you have a commonly available modem, click the  Vendor
button to choose from a list of modems for which all the details required by WinRamp Lite have
already been set-up. In this case, most of the device settings will be filled in for you, and you can
press OK for  WinRamp Lite to accept your device.  If you have a serial connection to the host,
check the Direct Serial Link check box so that all the modem commands are disabled to enable
the connection.

If you know the settings required for your device, change the settings shown before you click OK.
If you are unsure, then leave the defaults as they are. The most important setting to check is the
COM  port  setting.  This  can  often  be  determined  by  checking  the  plugs  at  the  back  of  the
computer for a label telling you which COM port the modem is plugged into. If you have an
internal modem, check your modem manual for the correct COM port.

The following settings are a good starting point for the device settings :

Parity:  None
Word Length : 8
Stop Bits : 1
Handshaking : RTS/CTS
RX Buffer   : 5120
TX Buffer   : 5120

The following provides an explanation for information required when setting up your device:

Device Name: 
What you would like to call the device - should be a descriptive name for the device for human
recognition.

Port: 
Which serial communication port the device is connected to. Most IBM compatible computers are
supplied with two serial ports, COM1 and COM2. Your mouse is usually attached to one of the
serial ports, and you can connect a modem to the other port. See your hardware documentation
for more details on which ports are available to you.
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Parity: 
Whether an extra bit is added to each byte to make the number of '1' bits even or odd.
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Word length: 
The number of bits used to represent a byte of data over the serial link.

Stop bits: 
The number of bits used to represent the end of a byte of data.

Baud rate:
The 'speed' at which data is sent over the serial link.

RX Buffer & TX Buffer: 
The amount of RAM used to store data on its way to or from the device. Used when Windows is
busy with another task, and WinRamp cannot immediately retrieve the data.

Handshaking: 
How Windows will  know when to temporarily stop sending data if, for example, the device's
buffer is already full. The handshaking will prevent Windows from sending data when the data
cannot be sent by the device.

You can also change the commands which are sent to the modem by clicking the Strings button..
The commands WinRamp Lite needs to know are: how to initialize the modem ready for dialout;
how to make the modem dial a telephone number, and how to tell when the modem has connected
to another modem. The default strings used are:

Dial: ATDT
Connect: CONNECT
Initialize: ATZ

3.1.2 Modifying Settings for a Device

To modify the settings for an existing device, select the device by  clicking on its name, then click
the  Edit button.  Modify  whichever  settings  are  required  to  customize  the  device  to  your
environment, and then click OK.

3.1.3 Selecting the Default Device

To select  the  default  device  (which  will  be  the  highlighted  device  whenever  you choose  to
establish a connection) select the device by clicking on it, and then click the Default button. The
device name will now be reflected in the box underneath the word "Default".

3.1.4 Removing an Unwanted Device
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If a device is no longer needed, it can be removed by selecting the device, and clicking on the
Remove  button.  The device will  be removed from the list.  THIS IS NOT A REVERSIBLE
ACTION - be sure that you no longer need the device before deleting it.

3.1.5 Copying a Device

If you have two similar devices, choose the  Duplicate button to make a copy of one device,
enabling you to change only the few settings which are different for the second device.

Each of the three communications methods specified above will now be described:

3.2 Command Line Dialing

Should you wish to dial a remote system manually, select the  Open Terminal option from the
Communicate menu. This will bring up the open terminal dialog box from which you select a
device and terminal emulation from the lists provided. Alternatively, you can select the defaults,
the details of which will appear on the status bar. Clicking on the OK button will then open a
terminal window, from which you can enter the manual dial command, or any other Hayes AT
command. Refer to Appendix E, or your modem manual, for details abut the commands you can
use.

3.3 Manual Dialing

Selecting Dial from the Communicate menu option will bring up the Dial Dialog box. The list of
devices you have set-up using the Device Configuration dialog box appear on the left. Select the
device you intend using for this connection (the default is automatically selected). On the right,
the list of pre-defined terminal types, and those you may have added, are listed (with the current
default highlighted). 

A terminal type must be selected since WinRamp Lite will "pretend" that it is a special piece of
hardware called a Terminal. Different types of terminals have different features - some will only
show CAPITAL LETTERS, others will show colors, and others will show graphics and let you
use a mouse to "click" on "buttons".  WinRamp Lite will emulate the following basic Terminal
types: 

TTY (a plain, text terminal); 
ANSI (text with colors and basic sounds); 
AVATAR (a superset of ANSI - more features); 
Prestel (as used by the British Prestel service, and France's Minitel);
Remote Imaging Protocol (RIP) (a recently developed graphical standard supporting a mouse
and graphics);
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VT52 (an implementaion of the DEC VT52 terminal);
VT100 (based on the specification for the C. Itoh CIT-101 terminal, and is supposed to be fully
compatible with the DEC VT100 terminal);
VT220 (a  partial  implementation  of  the  DEC  VT220  terminal  based  on  the  DEC  VT320
specification).

The emulation you choose will be determined by the system you wish to connect to. If you have
seen a Bulletin Board System, or other Online System which advertises itself as having a "RIP-
based graphical  interface",  then you should choose the RIPScrip (default)  terminal  emulation
from the list presented on the Dial dialog. If you are unsure which emulation a system uses, then
ANSI (default) is probably your best choice.

You can tell if you are using an incorrect emulation - generally the screen will not appear as you
expected it to! Symptoms can range from little arrows and left-square brackets appearing when
you choose TTY instead of ANSI, to getting streams of lines starting with an asterisk (*) when
you should have chosen RIPScrip emulation.

There are also advanced settings for each default emulation (this is why each emulation has the
word "default" behind it - you can create other emulations based on the standard emulations, with
certain features disabled, or configured differently.) See the section on Terminal Emulators in
Chapter 5 for details on how to configure settings.

The final step to making a connection is to enter the telephone number of the remote system. This
should be the number of the modem on the remote side which is most compatible with your own
modem. Basically, if the system offers two separate numbers, one for high speed and one for slow
modems,  and you have a fast  modem, then you should use the number for  their  high speed
modems.

To enter the number, click on the telephone number field, and type in the telephone number you
wish to call, including any dialing codes needed. WinRamp Lite "remembers" the last ten numbers
you have  dialed  and provides  these  in  the  drop  down list  box,  with  the  last  number  dialed
displayed at  the  top.  Click the  OK button,  and you are  on your  way!  A window will  open,
showing the progress of the call (you can cancel at any time), and once connected, the terminal
window will open. You can now start interacting with the online system you connected to.

3.4 Using the Dialing Directory

The dialing directory performs the same function as a rolodex, or telephone directory. You capture
information  about  online systems you frequently call  as  a  directory  entry,  and then you can
simply click on an entry to initiate a connection to that system.

You can have multiple directories (shown along the bottom as notebook tabs), each with multiple
entries (shown along the right as alphabetic tabs). Each entry stores information about a particular
system - the name, telephone number(s), device and speeds to use. 
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3.4.1 Opening the Dialing Directory

Click on the dialing directory icon from the main toolbar, or choose the Dialing Directory option
from the Communicate menu. The Dialing Directory window will then be displayed. On the left
of the directory, there are alphabetic tabs much like you'd expect to find in an address book,
except that there are tabs for only those letters for which there are entries.  (As you add new
entries, alphabetic tabs for these will automatically appear if they don't already exist). The tabs at
the  bottom  of  the  dialing  directory  represent  personal  address  books.  These  you  can  create
according to how you would best like to organize and group directory entries, e.g. local BBSes,
product support systems,  etc.   

You will notice that having opened the dialing directory, the menu bar has changed to include a
"Directory" option. The dialing directory toolbar had also been added. To move this toolbar click
on any part of the gray background of the toolbar and drag it to a new location (see toolbars
section in this manual for more information on moving and configuring toolbars). The Directory
menu option or tool bar are used to create and remove new directories and  directory entries, and
other options, as explained below. 

3.4.2 Directories

Before entering details about a system (e.g. BBS) you'd like to communicate with, decide which
directory you'd like to store the details under. Organizing your directory entries depends totally on
how you'd like to group them - using a multiple directory system certainly helps later when you
have many entries to keep track of. To add a new directory, choose  New Directory from the
Directory menu or toolbar. You will be asked for a name for the new directory, which will appear
as  another  tab  along  the  bottom  of  the  Dialing  Directory  window.  To  remove  an  existing
directory, chose Delete Directory from the same menu. This will ask for confirmation if you'd
like to remove the current directory. Remember that all entries in that directory will be deleted
too!

3.4.3 Directory Entries

To add a entry to the  dialing directory,  choose the  Add option from the  Directory menu or
toolbar,  and  fill  in  the  details  for  that  system.  You will  notice  that  the  dialog  box is  called
Directory Entry Details: Dial-Up Systems. This is to allow for future growth of  WinRamp Lite
where the product will provide support for other methods of communication, e.g. LANs. 

Enter the name and number of the host system. You can enter more than one telephone number,
by placing the cursor on a blank line in the number field, and typing the new number. Then, when
you dial,  WinRamp Lite will cycle through all the numbers, until it finds one which is not busy.
Defaults are provided for the terminal emulation, device name and file transfer protocol you wish
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to use for this system. Click on the help button if you are not sure what to enter for any specific
item. Should you already have a login name and password for the system, enter these in the
relevant fields.

The bottom portion of the Directory Entry Details dialog box displays statistics about the online
system the entry applies to. This will tell you the date you last logged onto the system, the total
number of times you have accessed the system, the number of files (and total bytes) you have
transferred  to  and  from  that  system,  and  the  ratio  of  bytes  uploaded  compared  to  those
downloaded. This last item is especially useful for those BBSes and online system that require
you to maintain a  certain ratio  of  uploads to  downloads.  Clicking on the  Reset button will
initialize these statistics to zero.

Clicking on the Directory tab will bring up another dialog box where more information can be
captured for the directory entry. Again a part of this dialog box has been developed to cater for
future versions of WinRamp Lite where a scripting language will be included. You can enter the
default path for macro files, file captures, uploads and downloads (see Chapter 4 for details on
when and how you can use these features), or click on the browse button to select the directory.
Marking the Start on Connect check box will cause  WinRamp Lite to automatically capture all
communications session with this host system to a file. You can choose a suitable icon for the
entry by clicking the Change button. This icon will then be used for "hot dialing" (see Hot Dial
section in manual). Any comments and notes can be entered for the directory entry so that they be
displayed directly on the dialing directory when you toggle Directory Tabs off. Finally, you can
specify whether or not a macro of your choice will automatically be executed when a connection
to the host pertaining to a particular directory entry is established. This can be done by selecting
the Macro radio button under the On Startup option.  Type the name of the macro file without
the extension in the field next to the  Macro radio button.  If the file is not in the Macro file
default path, change the default path to the one that the file is in.  Later versions of WinRamp Lite
will allow you to startup the connection with a script.

The Edit menu option on the Directory menu allows you to change items of information about
the entry (as does clicking on an entry with the right mouse button), while the  Delete menu
option removes the entry.

3.4.4 Connecting to a System

Once you've set up the directory entry for a particular system you wish to connect to, double click
on the system's name, or select  Dial from the  Directory menu option.  WinRamp Lite will then
attempt to connect to that system. A Dialing window will appear with the name and number (or
numbers)  of  the system.  WinRamp Lite will  start  dialing the first  number that  appears in the
Number text box, cycling the next if the elapsed time exceeds the total time you have specified
before the program should "time-out' or stop trying. Every time WinRamp Lite attempts to redial
the system, the number in the Attempts text box will increment by one.

Page 32



3.4.5 Locating a System

To find a system, you can click on the alphabetic tabs to the right of the dialing directory. Each
tab will show all systems whose names start with that letter, enabling easy access to the system
you are looking for.

3.4.6 Customizing the Dialing Directory

The lines separating each of the items of information about an entry (name, terminal emulation,
device, etc.), can be dragged using the mouse to increase or decrease the size of the item holder.
Thus if you have a long name for the entry, you would drag the dividing line to the right so that
the entire name could be displayed. Selecting or deselecting (when selected the option has a tick
symbol  on the left) the Directory Tabs options in the Dialing Directory will toggle the display of
the  directory  tabs  at  the  bottom  of  the  dialing  directory.  When  this  option  is  not  selected,
comments and numbers text boxes appear at the bottom of the dialing directory instead of tabs.
Comments for a particular entry are entered when adding or editing a directory entry. If an entry
has multiple numbers, these will appear in the Numbers text box.  Toggling the  Quick Select
Tabs option on 
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or off will display or remove the alphabetic tabs appearing on the right of the dialing directory.
Similarly,  the  Toolbar option  can  be  toggled  depending  on  whether  you  want  the  Dialing
Directory toolbar to be displayed or not. Since the dialing directory is a window, you can resize,
move and minimize it just like any other window.

3.5 Hot Dialing

The hot dial facility has been designed for speed dialing of those system you use frequently.
Clicking on the Hot Dial icon from the main tool bar or selecting the Hot Dial option from the
Communicate menu will launch a special Hot Dial window. This appears much like a typical
Windows program group consisting of a number of icons. Each icon represents a system entry
you have setup in the dialing directory. Double clicking an icon in the hot dial directory will
prompt WinRamp Lite to begin dialing the system, bringing up the Dialing dialog box. 

To setup an icon in the hot dial window, use the dialing directory. When adding or editing a
directory entry in the dialing directory, you have the option of marking the entry to be available
for hot dialing, and for selecting an icon to represent the entry in the Hot Dial Window.
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CHAPTER FOUR:     MANAGING A COMMUNICATIONS SESSION

Having successfully  connected  to  a  remote  system,  there  are  many functions  WinRamp Lite
supports during the communications session. These features include uploading and downloading
files, capturing incoming data to file, cutting and pasting sections from the terminal window to
the  Windows  clipboard,  recording  and  playing  back  macros  and  many  more.  Much  of  this
functionality is only made possible due to the multi-tasking capabilities of  Windows,  so take
advantage of it!

4.1 Transferring Files

When connected to a host system, one of the most important functions you may want to perform
is transferring files to and from your PC.  In order to do this, you need to select the transfer
protocol you wish to use and specify file name(s) and directories (depending on the protocol). A
Protocol is a set of rules and standards governing communications between computers. Default
protocols have been setup in WinRamp Lite. Advanced users may wish to customize these default
protocols. (For details on how to do this, refer to Chapter 5.) A description of each of the default
file transfer protocols is provided below, followed by details on how to upload and download
files:

4.1.1 ASCII Transfer

This is a simple transfer protocol,  involving no error checking nor compression.  This sort  of
transfer is of most use when you have a small piece of text to move across the line, and a very
clear connection (i.e. your modem is already providing error correction.)

Disadvantages
· Transmits files in 7-bit format only. Special characters in the text could cause the link to

freeze (e.g. the XON and XOFF flow control characters).
· Tends to be slow.
· Can only handle one file at a time (although some versions may support batch file transfers).
· No control information is sent.

Advantages
· Quick and dirty way to get text across the line.
· Useful for entering text into an online editor without having to re-type it.

4.1.2 Xmodem

Xmodem is one of the original PC-to-PC file transfer protocols and is offered by most BBSes and
online systems. It uses 128-byte blocks when transferring files, adding an extra byte (a checksum)
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to each block for error checking, thereby achieving approximately 95% reliability. 
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Disadvantages
· Transmits files in 8-bit format only.
· Tends to be slow.
· Can be unpredictable if used with modem error-checking and flow control. 
· Can only handle one file at a time (although some versions may support batch file transfers).
· No control information (e.g. file name and date) is sent.

Advantages
· It is relatively easy to use.
· More reliable than ASCII transfers.
· Common.
· Relatively effective error-checking.

Xmodem/CRC
Xmodem/CRC (cyclic redundancy check) is a more sophisticated version of Xmodem, in that it
provides improved error-checking. This has the advantage of improved reliability (approximately
99,6%).

Xmodem-1k
This is the same as Xmodem/CRC except that it uses 1024 block sizes instead of 128. It is faster
than Xmodem when there is little or no “line noise”, or interference, on the phone line.

4.1.3 Ymodem

Ymodem is actually another variation or derivative of X-modem, specifically Xmodem-1K. It
transmits data in 1024-byte (1-KB) blocks or 128-byte blocks. A variation called Ymodem-G has
no error-checking and is therefore even faster.

Advantages
· Useful for transmitting large files.
· Faster transfer speeds.
· Automated batch transfer of files.
· Adds control information, such as file name.
· Useful with a MNP or V.42 modem (refer to Appendix D).

Disadvantages 
· Usually no error-checking.
· Slow if line noise exists on the phone line.
· Use of padding blocks may corrupt binary files.
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4.1.4 Zmodem

This  public  domain  protocol  is  the  most  popular  file  transfer  protocol  used  in  PC
communications, especially with high-speed modems. Zmodem uses 512- or 1024-byte blocks.
We recommend you use this protocol with WinRamp Lite. 

Disadvantages
· Uses no buffering.

Advantages
· Relatively fast.
· Reliable (approximately 99%).
· Allows batch transfers.
· Efficient with high speed modems.
· Crash recovery for incomplete transfers.
· Widely used.

4.1.5 Kermit

Kermit is primarily used to transfer files from mainframe or mini computers and is unique in that
it  can transfer 8-bit  files  over a 7-bit  data  link.  It  has  the  ability to  use flexible block sizes
although small data blocks are the norm. The checksum technique is used for error checking.
Kermit can change control characters to other ASCII characters to improve reliability.

Disadvantages
· Not very common.
· Small block sizes reduces throughput.

Advantages
· Reliable.
· Allows flexible batch downloads.
· Useful with 7-bit data links.

4.1.6 Downloading

Selecting Download from the File menu will bring up a dialog box allowing you to choose where
to place a file you wish to download (receive from the remote system), and what the filename will
be.  Because certain download protocols have internal  support  for filenames,  choosing one of
these protocols in the list box on the right may prevent you from modifying the filename field.
For example, YModem and ZModem allow multiple files to be sent at once, in which case the
remote  system will  send the  correct  filenames  automatically.  Once you choose  OK,  the  two
computers will start the process of transferring the file. 
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Note that with some protocols, if you spend an extended period of time before choosing OK, the
protocol may fail. In this case, simply instruct the remote system to resend the file, and choose
Download again. Also, some protocols will automatically initiate a download, as is the case with
ZModem. In that case, there is no need to manually select Download.

If you are downloading GIF files using XModem, YModem or ZModem, you can turn the GIF
Viewer on by selecting Preferences from the Configure menu and clicking on the Misc tab and
checking the Auto Display GIF box under the file receive section.  This will automatically display
the GIF file that is being downloaded.

4.1.7 Uploading

Selecting Upload from the File menu during a communications session will bring up a file dialog
box where you can choose which files you wish to send to the remote system. Certain protocols
will allow you to send more than one file at a time. If one of these protocols is selected in the list
box in the upper right, you will be able to list multiple files in the list at the bottom of the dialog.
Protocols like XModem will restrict you to sending only one file at a time. To upload a particular
file, double-click the file in the upper list, to transfer the filename to the lower list. Uploading text
(as opposed to files) can also be performed, using the text transfer “protocol”.

Refer to the troubleshooting guide in Appendix B for suggestions on how to correct problems you
may be having with file transfers.

4.2 Changing Terminal Emulations

During a communications session, you can change the settings of your current terminal 
emulation, without having to cancel your current communications sessions and start another. Use 
the Current Terminal from the Configure menu.  Further, you can select a different terminal 
emulation (also without interrupting the active communications session) by selecting the Open 
Terminal option from the Communicate menu.  Ensure that the selected COM port in the Open 
Terminal window is the same one as the one for the already active session and select the Terminal
type you would like to see in the new window.  This would allow you to, for example, open a RIP
emulation window in addition to the ANSI one already open of the same data stream.  It is 
important to ensure that the Port Sharing option in the Directory section of the Preferences is on 
Prompt or Automatic to enable you to see the data stream in a different emulation.  In order to 
change the Port Sharing setting, select Preferences from the Configure menu and click the 
Directory button.  Select either Prompt or Automatic under the Port Sharing option and click 
the OK button.

4.3 Cutting & Pasting Text and Graphics
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You can mark out  an area  on the terminal  window to copy to the  Window’s clipboard as  a
bitmapped image or as text characters, by selecting the  Mark Graphics or  Mark Text options
from the Edit menu and then choosing Copy from the same menu. The Paste option in the Edit
menu will copy the contents of the windows clipboard as keypresses to the remote system.
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4.4 Using the Command Stack Window

You  can  open  the  Command  Stack  window  by  selecting  Command  Stack from  the
Communicate menu.   A command stack  window is  a  facility  which  allows  you to  type  in
commands and store these commands so that they can be executed in the terminal window at a
later stage and as many times as you specify. This option facilitates Type-ahead i.e. you can type
in the next command while you are waiting for the command prompt and then press Enter when
the command prompt appears thereby minimising the connect time.  The other situation in which
the Command Stack is useful is when you are using Chat  Mode.  Normally, if you are busy
typing in your chat message in a teleconference facility, you are not able to see other people's
message until you have sent yours.  By using the Command Stack, you can see all the messages
as they are sent and be able to type your message with full edit capabilities i.e. cut & paste, arrow
keys etc.  The Command Stack option is also very useful when using Multi-user Dungeons as it
allows you to repeat previously executed commands and overcomes the problem of the screen
scrolling while you are in the process of typing.

The following functions can be performed in the Command Stack window:
· Ctrl-Enter performs a line feed but does not send the line.
· Enter performs a line feed and sends the line.
· Ctrl-Home goes to the top of the window.
· Ctrl-End goes to the bottom of the window.
· Ctrl-Ins copies the selected text to the keyboard.
· Shift-Ins pastes text that is in the keyboard.

4.5 Capturing Communications Sessions to File

You can capture all incoming characters to a file, for later reviewing, by clicking Start Capture
from the  File menu.  Data  capture  is  simply writing to  disk the characters  you type and the
incoming text that scrolls on your screen.  It is particularly useful when you want to capture a text
file  from another  computer  but  the  system doesn't  allow downloading.   (This  feature  is  also
known as an "ASCII download".)  Data capture is also useful for keeping a log of your online
activities (especially when you're learning to use an online service or BBS) and keeping disk
"carbon copies" of e-mail. 

When you choose the  Start Capture menu option, you will be prompted for a file name and
directory to save the data to. You will notice a flashing icon appearing on the status bar, indicating
that  WinRamp  Lite is  currently  capturing  data.  Selecting  Stop  Capture will  terminate  the
copying of received characters to a file

An alternative method of capturing your communications session to file is to capture data that is
being stored in the buffer. This is useful when you want to save part of the communications
session that has already happened - i.e. when it is too late to use the Start Capture feature. Use
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the Capture Scrollback option from the File menu to perform this operation.
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4.6 Toggling Scrollback Mode on or off

Marking the Scrollback option in the Edit Menu defines whether the scrollback bar is visible on
the right of the terminal window (this option is thus only available when a terminal window is
open).  The  scrollbar  allows  you  to  move  back  through  data  you  have  previously  received.
However, if the bar takes up too much room, you can switch it off. 

4.7 Toggling Doorway Mode On or Off

This option allows the sending of the IBM keyboard scancodes to the remote system. This is
required when using some remote-access programs, and some BBSes. This allows the remote
system to realize when you have pressed keys like the Alt key, and both Shift keys. This is often
referred  to  as  "Raw  Mode",  or  "IBM  keyboard  mode".  Choose  Doorway  Mode from  the
Communicate menu  to  set  this  option.  When  doorway  mode  is  on,  none  of  the  standard
Windows keyboard commands will work, so you will need to use your mouse instead.

4.8 Recording and Playing Back a Macro

Any sequence of keyboard presses (i.e. typed text) executed during a communication session can
be recorded as  a macro by selecting  Record Macro  from the  File  menu and assigning that
recorded sequence a .mac file name.  The same sequence of actions can be executed once a
connection  is  established  and  the  Playback  Macro  option  is  selected  from the  File  menu.
During playback, a macro can be played, paused, resumed or rewound.  The speed at which you
would like the macro to execute can be specified by setting the speed scrollbar during playback.

4.9 Using WR-Script

WR-Script is WinRamp Lite's programming language which allows you to automate events such
as logon, logoff, download etc.  There are two ways in which a WR-Script can be created: by
using the WR-Script Integrated Development Environment (IDE) or by using the WR-Script
AutoLearn facility.  To write a script in the WR-Script IDE, select the  WR-Script IDE option
from the Scripts menu or click the WR IDE button in the Scripts toolbar (refer to the WR-Script
Function Reference).  You can write, debug and compile a script in the IDE.  A Compile Script
option is also available in the  Scripts menu so you do not have to launch the IDE in order to
compile.

A WR-Script AutoLearn script is similar to a macro in that they both record the actions that you
perform during a communication session and replicate these actions when you execute them.
They can also both be used to perform an automatic logon.  The main difference, however, is that
a macro records  only the actions you perform whereas an AutoLearn script  records  both the
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actions you perform as well as how the BBS responds.  Due to this difference, an AutoLearn
script may be more reliable than a macro.  To enable the AutoLearn facility, select the WR-Script
AutoLearn option from the  Scripts menu when you want to start recording and deselect  WR-
Script  AutoLearn when  you  are  ready  to  stop  the  recording.   If  the  AutoLearn  Automatic
Compile on Close is checked in the Miscellaneous section of your global preferences, you will
not need to compile the AutoLearn script and can run it by selecting Run Script Object from the
Scripts menu or by clicking the Run Script button.  If you are creating an AutoLearn logon script,
you can  make  use  of  the  option  available  in  the  Directory  section  of  the  Dialing  Directory
settings.  The On Startup and Script/Macro Action options allow you to attach a logon script to
the dialing directory entry of your choice (refer to section 3.4.3. Directory Entries for details of
how to do this).

4.10 Single Commands

Various commands can be sent directly to your modem, using the Communicate menu. These are
Hayes AT commands (refer to Appendix E). These commands are: Send Break, which sends a
break  command  to  the  modem,  overriding  coded  communication  thereby  interrupting  and
resetting the current process; Full Duplex, which toggles between full duplex (simultaneous, bi-
directional communication) and half-duplex (bi-directional communication,  but only one way at
a time); Reset Modem, which allows you to reset the modem using the method specified in the
current device settings; and finally Auto Answer, which sets your modem to auto answer mode
( the equivalent of sending an ATA command string to your modem), for when you wish your PC
to act as a host (refer to Tricks and Tips in Appendix B).

4.11 Ending a Communications Session

When you wish to terminate the current telephone connection using the method specified in the
current device configuration (either drop the DTR line, or send a specific string to the modem,
causing  it  to  drop  the  telephone  line),  choose  Hangup from  the  Communicate menu.
Alternatively, choosing Exit & Hangup from the  File Menu will exit  WinRamp Lite as well as
disconnecting the current telephone connection.
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TUTORIAL:     LOGGING ONTO THE WINRAMP SUPPORT BBS

This tutorial demonstrates how to log onto the WinRamp Lite Support BBS in order to register
the product. Once you have registered, you can use the support BBS to ask questions, leave mail
and download upgrades etc. The BBS software was developed by Vironix.

In order to register online through the WinRamp Lite Support BBS, do the following:

Set WinRamp Lite to use the highest baud rate your modem supports. You will be connecting to
an HST Dual Standard modem on the BBS.
.
Select Manual Dial, and enter the number of our BBS.

Once you have established a connection, you will see a login message telling you to enter the
username 'register' to register your product. Type in the word 'register', and press Enter.
You need to fill in a few personal details, to enable us to ship your registered copy of WinRamp to
you. MISTAKES CAN BE CORRECTED AT THE END - DON'T PANIC!

Take special note of how you entered your name - you will need to enter the name in exactly the
same way into WinRamp Lite to register your product.

Select the credit card type you wish to have us debit, and enter the details off your credit card.
Then,  select  which  product  you  wish  to  purchase,  either  the  registered  WinRamp  Lite with
manual, or without manual.

You will now be given a chance to modify any of the information you have entered - press the
number of the line you wish to correct, and re-type the entire line.

Once you are satisfied that everything is correct, press the number 0 (zero) to continue. If your
credit  card  number  is  invalid,  you  will  be  asked to  re-type  your  credit  card  number  before
continuing.

Finally, you will  be shown the total  which will  be charged to your credit  card - press 'Y'  to
confirm the transaction. DO NOT PRESS Enter AFTER THE 'Y'!

Your registration number will be shown on the screen - write this down in a safe place, along with
the exact form of the name you entered. You will be sent a printed copy of this information as
proof of registration, but this may take a few days to arrive.

Press Enter to terminate the connection.

All that remains is to enter your name and registration number into any 'Register...'  dialog in
WinRamp. Choose Register from the menu, and type in the details.
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Congratulations! We thank you for your support in selecting our product.
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CHAPTER FIVE:     CONFIGURING WinRamp Lite

This chapter provides details on how to optimize your communications environment so that it
facilitates communications using WinRamp Lite. Customization ranges from setting up your own
toolbars to configuring file transfer protocols.

5.1 Toolbars

All toolbars are completely configurable, and provide easy access to all WinRamp Lite functions.
You can set  up toolbars with the functions you use the most  often,  to speed up your use of
WinRamp Lite. There are four default toolbars that are loaded when you first install WinRamp Lite
- the Standard toolbar, the Configuration toolbar, the Online Actions toolbar and the Scripts and
Macros toolbar. Clicking on the Toolbars option from the Configure menu will provide you with
a list of these available toolbars (and any others you may have added). Those marked with a tick
represent  toolbars  that  are  currently  displayed  (only  the  standard  toobar  is  displayed  when
WinRamp Lite is first loaded). These available toolbars can be toggled on and off, allowing you to
display as many as you require.

To modify these toolbars, or create your own, select the  Toolbars option from the  Configure
menu. Select Edit to display the Toolbar Editor. Here you can modify an existing toolbar, create a
new one, and rename or delete an existing one. The available actions and their representative
icons are shown in the two list boxes. The list box on the left shows those buttons that already
exist on the toolbar (this will be empty when you create a new toolbar), while the right-hand list
box provides a list of all available buttons which you can add to the toolbar. To add buttons to the
toolbar, select those you want from the list of available buttons and click the arrow button that
appears between the two list boxes. Alternatively, click on the button you wish to add and drag it
to the Toolbar Buttons list box.

You can also remove buttons from the toolbar, by clicking the Remove button and change the
order in which buttons appear on the toolbar by using the Up and Down buttons or by clicking
on, then dragging the button the desired location.. To create a new toolbar, click on the  New
button and type in a name for it. Click on the OK button, then select those buttons you require to
appear on the toolbar. Click on  OK to signify you have finished. The check boxes appearing
under the show section will be available in future releases of WinRamp Lite.

Once  you  have  configured  the  toolbars  to  meet  your  own  requirements,  you  can  move  the
toolbars around the screen by clicking on any part of the gray toolbar background and dragging it
to a new location. When dragged away from the borders, the toolbars become their own resizable
windows. By “knocking” the toolbars against any of the borders, it will anchor itself to the border
and become part of it. In this way your communications desktop can be totally configured to suit
the way you work.
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5.2 Setting Preferences

Most preferences can be set using the Preferences option from the Configure menu. Choosing
this option will result in the Preferences dialog box being displayed. The following categories of
preferences can be set:

5.2.1 General

Terminal Window Initial Size:
When a terminal emulation window is opened, should it be in a maximized state, or should it
open to its default size, based around your equired number of lines and columns?

Application Open Size:
Should WinRamp Lite be opened with a full size, maximized window, or would you rather save
the settings each time you exit so that it opens the same size as you were last working with?

Toolbar Tips:
The tool tips are the explanatory text which describe the function of a toolbar button. These tips
come up if you position the mouse over a button, and leave it there for a short period of time. Set
your preferences to indicate whether you want the tips displayed or not, and the delay before they
should appear.

Text Editor:
Allows you to specify your preferred text editor (e.g. notepad.exe), which is accessed by clicking
on the Text Editor option from the File menu.

Confirm Exit:
This option controls whether you or not you would like  WinRamp Lite to prompt you before
exiting.

5.2.2 Terminal

Cut & Paste

The cut and paste functions of WinRamp Lite  allow you to copy text or graphics captured from a
communications session to the Windows clipboard. Options available are:

Translate Text: 
The Windows character sets do not all support the same characters as ANSI and other emulation
character sets. This option determines whether, when copying to the clipboard, WinRamp Lite will
try and substitute a "next best thing" approximation.

Append Carriage Return:
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When you have selected a block of characters, should  WinRamp Lite separate subsequent lines
with a carriage return character, or copy only the visible characters to the screen?

Quote Paste:
This option controls whether or not any special characters are inserted in front of any text you
paste in a terminal window.  Enabling this option will result in the characters defined in the String
setting (see below) to be inserted at the beginning of every line.  This can be useful when you
want to reply to a message online and need to quote from the original message.

String:
The Select and Paste edit facilities enable you to mark text and paste it in a terminal window.
This 
option allows you to define the string that will precede anything you paste in a terminal window
so 
that it can be easily identified.

Cut & Paste - 2nd Click

Undo Selection:
When this option is selected, you can undo the selection block by clicking the mouse for the
second time inside the selection area.

Select Word:
When this option is selected, the second time you click the mouse in the selected area will select
the word underneath the cursor.

Paste Selection:
When this option is selected, you can force WinRamp Lite to paste the currently selected block of
text by clicking the mouse for the second time inside the selected area.

Select Word & Paste:
When this option is selected, the second time you click the mouse in the selected area will select
the word underneath the cursor.

Separators:
This option is related to the selection of a word in a terminal  window. You can define what
WinRamp Lite should consider a word by specifying the  characters that will be considered to be
separators.  It is possible to define upto 20 separators.  Any character below ASCII 31 or above
ASCII 128 as well as a space are automatically considered to be separators.

General

Color Flashing:
Specifies whether the text flashing attribute in the ANSI terminal emulation will be supported or
not.  You may wish to disable this if you have a slow computer.
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Fast Scroll:
When this option is enabled, scrolling operations in any of the text emulations are performed
much faster by only redrawing the screen every couple of lines.

Strip Capture:
Marking this check box will prevent the control characters (i.e. characters that control the text
color  and  font)  of  the  communications  session  from  being  captured,  thus,  capturing  only
meaningful and readable text to the capture file.

Low ASCII:
Determines whether or not any of the terminal emulations display characters below ASCII 32 in
the IBM characters set, i.e. special characters.

Scrollback Buffer

Defines how much memory is reserved to hold data which has scrolled off the top of the screen.
You can use the scrollback buffer to see data you recently received, but which has disappeared
from view to make way for other data. Use the  Capture Scrollback command from the  File
menu, or by setting Scrollback on, from the Edit menu.

5.2.3 Device

Modem

Hangup on port close:
Specifies whether the DTR line will be dropped and any modem connection terminated when you
close all windows which were using a particular device. If you clear this checkbox, you should
manually terminate a telephone connection.

Close Window on Hangup:
Closes the terminal window automatically when the modem drops carrier, i.e. hangs up.

Confirm Modem Hangup:
Determines  whether  you  are  asked  to  confirm  the  action  of  hanging  up  the  modem before
WinRamp Lite does it.

Confirm Session Resume:
Determines whether you are asked to confirm whether you want to resume a session or not.
Resuming a session means that your modem will not be reset and you can continue using it.

Port Sharing

This setting is very important if you want to view the same incoming data stream in more than
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one terminal emulation.  You can choose to Disallow port sharing i.e. you will not be able to open
more than one terminal emulation, you can choose to Automatically share the port when you open
another window or you can ask WinRamp Lite to Prompt you i.e. you will be asked whether you
want to share the port or disallow sharing evry time you want to open another terminal window.

Directory

Automatic ReDial:
This setting is applicable only to Dialing Directroy entries.  It determines whether WinRamp Lite
automatically starts dialing the first number again on the list of numbers for the selected Dialing
Directory Entry once it has not been able to connect to any of them.

Directory Toolbar:
Determines whether the Dialing Directory toolbar appears on the screen when Dialing Directory
is selected from the Communicate menu or when the Dialing Directory button is clicked on.

Minimize on Dial

Hot Dial Window:
Determines whether the Hot Dial window will be minimised once you begin the dial procedure.

Dialing Directory:
Enabling this setting causes the Dialing Directory window to be minimised once you have begun
the dial procedure.

5.2.4 Paths

Scripts:
Allows you to specify the default directory for any WR-Script programs and sources scripts you
may have developed.  

Macros:
Determines  the  default  directory  for  any  Macros  that  you  may  have  written  for  automation
purposes.

Capture:
The default directory for the capture file to be kept.

Downloads:
The default directory to which all the files to be dowloaded will be written.

Uploads:
The default directory on your computer where any files that you may want to upload are stored.

Page 51



5.2.5 Miscellaneous

File Receive

Check Disk Space:
Checks disk space before beginning a download procedure.  If the file is too large you will be
warned before the transfer takes place if the setting is on.

Delete Partial Files:
Deletes any files that might have been only partially dowloaded due to an error or if you pressed
Cancel during the download procedure.
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Auto Display GIF:
This  option  enables  or  disables  the  GIF viewer  during  the  download of  a  GIF(CompuServe
Graphic Interchange Format) file.   Once this check box is enabled, the GIF file that is being
downloaded will be displayed during the download process.

CR-LF Translation

Some hosts have either just a Carriage Return or a Line Feed at the end of a line in the incoming
data stream.  In order for the terminal to be displayed correctly it is necessary to add a Line Feed
before the existing Carriage Return or a Carriage Return before the existing Line Feed.  Leaving
the setting at None should accommodate most hosts.  It may be necessary to change the setting to
either LF after CR or CR before LF depending on the host.

Script Interpreter

Runtime Type Checking:
When runtime type checking is on, the script interpreter will check the parameters to all functions
and operators while the script executes.  Since all  operator and parameter type information is
checked  at  compile  time,  an  invalid  parameter  probably  means  the  script  image  has  been
corrupted.  This option slows the script execution down marginally, but it is recommended that
you leave it ON unless speed is at an absolute premium.

AutoLearn Escape Sequence Checking:
Escape sequences are special control characters used by terminals.  For example, they are used in
ANSI to control, among other things, color.  With this option on, only the actual text being send is
processed - escape sequences are ignored.  This can sometimes make it easier for the autolearner
to recognize certain strings.  Unless you encounter problems, it is recommended that you leave
this option off, as certain terminals send only escape sequences.

AutoLearn Automatic Compile on Close:
Determines whether a recorded or "autolearned" script will be compiled automatically after the
recording of the script has ended, or if it should be done manually. 

5.3 Terminal Emulations

The  terminal  emulations  are  supplied  with  standard  settings,  which  are  applicable  for  most
situations. However, if you connect to certain online systems which require something special,
you will  have to customize one of the base emulations to perform the special processing you
require. This may be as simple as adding Carriage Return characters, or as difficult as re-mapping
your entire keyboard. The possible configuration changes you can make are described below. 

To configure a terminal emulation, select the Terminal menu option from the Configure Menu.
The Terminal Configuration dialog box will  then be displayed, with the names of the default
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terminal emulations displayed.  Editing or adding a terminal emulation (by clicking on  Edit or
Add) will bring up the Terminal Settings dialog box. You can also Remove, Duplicate and set as
Default any of the terminal emulations shown by selecting it then clicking the relevant button.
Clicking on  the  Setup button  from this  dialog box will  display  the  default  settings  for  that
terminal type. The settings for each terminal type are explained below: 

5.3.1 The TTY Emulation

This is the most basic of the terminal emulations, supporting plain text.

Font Size:
The size of the characters as they are displayed on your screen.

Lines, Columns
How many characters there are across the width of your "virtual screen", and how many rows
there are. These affect when characters will wrap to the next line, and when the entire screen will
start scrolling up.

Destructive BackSpace
Whether a received BS character will simply move the cursor left, or the characters will be erased
as the cursor moves left.

Destructive Tabs
Will a received TAB character overwrite characters as it moves to the right, or will the cursor
position simply change.

Column Wrap
Defines whether characters received after the last column on the right will be shown on the left of
the next line. Basically like a typewriter, which beeps when you hit the right margin, and moves
down to the next line.

Fast Mark
Off means that dragging the mouse around the terminal window does not select text for copying,
Text  means that  complete  characters  will  be  marked off  for  copying,  Graphics  means that  a
bitmap image is prepared for copying to the clipboard.

5.3.2 The ANSI Emulation

ANSI Terminal emulation is one of the most common terminal emulations, it supports text with
colors and basic sound.

Font Size
The size of the characters as they are displayed on your screen.
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Lines, Columns
How many characters there are across the width of your "virtual screen", and how many rows
there are. These affect when characters will wrap to the next line, and when the entire screen will
start scrolling up.
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Destructive BackSpace
Whether a received BS character will simply move the cursor left, or the characters will be erased
as the cursor moves left.

Destructive Tabs
Will a received TAB character overwrite characters as it moves to the right, or will the cursor
position simply change.

Column Wrap
Defines whether characters received after the last column on the right will be shown on the left of
the next line. Basically like a typewriter, which beeps when you hit the right margin, and moves
down to the next line.

ANSI Music
ANSI emulations allow certain received characters to cause the playing of musical notes. If this
annoys you, you can turn it off, and experience the sounds of silence. Note that the Start ANSI
Music and Delete Line Codes in ANSI are the same, which may result in the terminal freezing.
Clicking Reset Terminal from the Communicate Menu should correct this .

Column Wrap
Defines whether characters received after the last column on the right will be shown on the left of
the next line. Basically like a typewriter, which beeps when you hit the right margin, and moves
down to the next line.

VT100 Wrap
Allows characters on the very last right-hand column, without the cursor wrapping to the next
line. 

Fast Mark
Off means that dragging the mouse around the terminal window does not select text for copying,
Text  means that  complete  characters  will  be  marked off  for  copying,  Graphics  means that  a
bitmap image is prepared for copying to the clipboard.

5.3.3 The AVATAR Emulation

This is a superset of the ANSI terminal emulation:

Font Size
The size of the characters as they are displayed on your screen.

ANSI Fallback
Allows the AVATAR emulation to interpret ANSI codes, if they arrive. Generally AVATAR is a
superset of ASCII, but some systems use ANSI codes for certain features and AVATAR for the
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rest.
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Lines, Columns
How many characters there are across the width of your "virtual screen", and how many rows
there are. These affect when characters will wrap to the next line, and when the entire screen will
start scrolling up.

Fast Mark
Off means that dragging the mouse around the terminal window does not select text for copying,
Text  means that  complete  characters  will  be  marked off  for  copying,  Graphics  means that  a
bitmap image is prepared for copying to the clipboard.

5.3.4 The Prestel Emulation

The Prestel terminal emulation is used by the British Prestel service and France’s Minitel.

Fast Mark
Off means that dragging the mouse around the terminal window does not select text for copying,
Text  means that  complete  characters  will  be  marked off  for  copying,  Graphics  means that  a
bitmap image is prepared for copying to the clipboard.

5.3.5 The RIPScrip Emulation

This is rapidly becoming one of the most popular terminal emulations. It is a recently developed
graphical standard, providing mouse and graphics support.

Button Hotkeys
RIP allows graphical buttons, which can have key combinations associated with them. The setting
determines if pressing the hotkey activates the RIP button, or whether you must click the mouse
on the button to activate it.

Field Tabbing
Allows the use of the Tab key to move between RIP buttons.

Protected Mode
Prevents the remote system from querying certain locally-defined variables containing sensitive
information. Any attempt to retrieve the information will ask for confirmation before the value is
returned to the requesting system.

Destructive BackSpace
Whether a received BS character will simply move the cursor left, or the characters will be erased
as the cursor moves left.

Destructive Tabs
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Will a received TAB character overwrites characters as it moves to the right, or will the cursor
position simply change.

ANSI Music
ANSI emulations allow certain received characters to cause the playing of musical notes. If this
annoys you, you can turn it off, and experience the sound of silence.

Column Wrap
Defines whether characters received after the last column on the right will be shown on the left of
the next line. Basically like a typewriter, which beeps when you hit the right margin, and moves
down to the next line.

VT100 Wrap
Allows characters on the very last right-hand column, without   the cursor wrapping to the next
line.

Fast Output
Allows graphics to be displayed faster, on certain 256 color systems only. This option has been
known to cause problems with some 256 color windows drivers, and may need to be disabled.

Icons Subdirectory
Where RIP icons which were sent from the remote system will be stored. If this directory does not
exist,  it  will  be created when there  is  data to be stored in it.  This is  a  subdirectory of your
WinRamp Lite base directory.

Fast Mark
Off means that dragging the mouse around the terminal window does not select text for copying,
Graphics means that a bitmap image is prepared for copying to the clipboard. Text copying is not
allowed, since RIPScrip is a graphical emulation. 

5.3.6 The VT52 Emulation

Font Size
The size of the characters as they are displayed on your screen.

Keypad
Both the VT100 and VT220 terminals have special keyboard "modes" that cause certain keys on
the keyboard to send different commands to the host system when they are enabled. Usually the
host system will instruct the terminal to enable or disable such modes, but if you find that your
keyboard isn't functioning as expected, you may want to try changing them manually.

Keypad Application Mode effects the numeric keypad and some of the surrounding keys (digits 0
to 9, the decimal point, the plus key, the minus key, and the enter key). Normally (when Keypad
Application Mode is disabled), the keys send through actual digits and characters as expected, but
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with Application Mode enabled, the keys will send through special escape sequences that the host
system will recognize.

Both the standard key mapping and the escape sequences produced when Keypad Application
Mode is enabled can be edited using the Key Mapping Editor.

Fast Mark
Off means that dragging the mouse around the terminal window does not select text for copying,
Graphics means that a bitmap image is prepared for copying to the clipboard. Text copying is not
allowed, since RIPScrip is a graphical emulation. 

5.3.7 The VT100 Emulation

Font Size
The size of the characters as they are displayed on your screen.

Keypad
Both the VT100 and VT220 terminals have special keyboard "modes" that cause certain keys on
the keyboard to send different commands to the host system when they are enabled. Usually the
host system will instruct the terminal to enable or disable such modes, but if you find that your
keyboard isn't functioning as expected, you may want to try changing them manually.

Keypad Application Mode effects the numeric keypad and some of the surrounding keys (digits 0
to 9, the decimal point, the plus key, the minus key, and the enter key). Normally (when Keypad
Application Mode is disabled), the keys send through actual digits and characters as expected, but
with Application Mode enabled, the keys will send through special escape sequences that the host
system will recognize.

Both the standard key mapping and the escape sequences produced when Keypad Application
Mode is enabled can be edited using the Key Mapping Editor.

Cursor Keys
Both the VT100 and VT220 terminals have special keyboard "modes" that cause certain keys on
the keyboard to send different commands to the host system when they are enabled. Usually the
host system will instruct the terminal to enable or disable such modes, but if you find that your
keyboard isn't functioning as expected, you may want to try changing them manually.

Cursor Key Application Mode effects the dark gray cursor keys to the left of the numeric keypad.
Normally they send through standard ANSI escape sequences for up, down, left and right, but
with Application Mode enabled they send through a different set of escape sequences that the host
system might require.

Both the standard key mapping and the escape sequences produced when Cursor Key Application
Mode is enabled can be edited using the Key Mapping Editor.
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Reverse Screen
Normally the terminal displays text in white on a black background, but with the Reverse Screen
option enabled, the colours will change to black on a white background.

Block Cursor 
Normally the terminal cursor is displayed as a flashing underscore, but with the Block Cursor
option enabled, it will change to a flashing block.

New Line Mode
When New Line Mode is enabled, line feeds, form feeds and vertical tabs perform a carriage
return as well as moving to the next line. When New Line Mode is disabled, they just move the
cursor to the next line, without performing a carriage return.

Also, when New Line Mode is enabled, the Return key sends through both a carriage return and a
line feed character, but when New Line Mode is disabled, only the carriage return is sent to the
host.

Column Wrap
Defines whether characters received after the last column on the right will be shown on the left of
the next line. Basically like a typewriter, which beeps when you hit the right margin, and moves
down to the next line.

Fast Mark
Off means that dragging the mouse around the terminal window does not select text for copying,
Graphics means that a bitmap image is prepared for copying to the clipboard. Text copying is not
allowed, since RIPScrip is a graphical emulation. 

5.3.8 The VT200 Emulation

Font Size
The size of the characters as they are displayed on your screen.

Keypad
Both the VT100 and VT220 terminals have special keyboard "modes" that cause certain keys on
the keyboard to send different commands to the host system when they are enabled. Usually the
host system will instruct the terminal to enable or disable such modes, but if you find that your
keyboard isn't functioning as expected, you may want to try changing them manually.

Keypad Application Mode effects the numeric keypad and some of the surrounding keys (digits 0
to 9, the decimal point, the plus key, the minus key, and the enter key). Normally (when Keypad
Application Mode is disabled), the keys send through actual digits and characters as expected, but
with Application Mode enabled, the keys will send through special escape sequences that the host
system will recognize.
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Both the standard key mapping and the escape sequences produced when Keypad Application
Mode is enabled can be edited using the Key Mapping Editor.

Cursor Keys
Both the VT100 and VT220 terminals have special keyboard "modes" that cause certain keys on
the keyboard to send different commands to the host system when they are enabled. Usually the
host system will instruct the terminal to enable or disable such modes, but if you find that your
keyboard isn't functioning as expected, you may want to try changing them manually.

Cursor Key Application Mode effects the dark gray cursor keys to the left of the numeric keypad. 
Normally they send through standard ANSI escape sequences for up, down, left and right, but
with Application Mode enabled they send through a different set of escape sequences that the host
system might require.

Both the standard key mapping and the escape sequences produced when Cursor Key Application
Mode is enabled can be edited using the Key Mapping Editor.

Reverse Screen
Normally the terminal displays text in white on a black background, but with the Reverse Screen
option enabled, the colours will change to black on a white background.

Block Cursor 
Normally the terminal cursor is displayed as a flashing underscore, but with the Block Cursor
option enabled, it will change to a flashing block.

New Line Mode
When New Line Mode is enabled, line feeds, form feeds and vertical tabs perform a carriage
return as well as moving to the next line. When New Line Mode is disabled, they just move the
cursor to the next line, without performing a carriage return.

Also, when New Line Mode is enabled, the Return key sends through both a carriage return and a
line feed character, but when New Line Mode is disabled, only the carriage return is sent to the
host.

Column Wrap
Defines whether characters received after the last column on the right will be shown on the left of
the next line. Basically like a typewriter, which beeps when you hit the right margin, and moves
down to the next line.

Fast Mark
Off means that dragging the mouse around the terminal window does not select text for copying,
Graphics means that a bitmap image is prepared for copying to the clipboard. Text copying is not
allowed, since RIPScrip is a graphical emulation. 
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5.3.9 Keyboard Mapping

Overview

In order for  WinRamp Lite to emulate different terminals correctly, it needs to be able to send
through specific character sequences when certain keys are pressed.  For example, on a VT52
terminal,  the  sequence  "<Esc>A" is  sent  to  the  host  system whenever  the  up arrow key is
pressed.  To complicate matters, certain terminals send through different sequences depending on
what keyboard "modes" are enabled.  For example, on a VT52 terminal, when the Application
Keypad  mode  is  enabled,  the  number  eight  key  on  the  numeric  keypad  sends  through  the
sequence "<Esc>?x" instead of sending the digit "8".

The terminal emulations provided with WinRamp Lite automatically handle these key mappings
for you, so you shouldn't need to change any of them.  However, you may want to setup key
mappings of you own to automate complex key sequences that you use a lot.  To do this, you will
need to use the keyboard mapper.

Selecting a Keymap

A keymap is associated with the terminal emulation from which it is derived.  To edit a keymap,
therefore,  you  must  first  the  select  the  required  terminal  emulation  from  the  Terminal
Configuration dialog (select  Terminal  from the Configure menu).  Click on the Edit button to
begin  editing  the  terminal,  and  then  click  on the Keyboard  Mapping button in  the  Terminal
Settings dialog - this will take you to the keyboard mapper.

You should now see a picture of a keyboard, with the current key mappings for the terminal you
are editing shown on each key. You can see what mappings are available while other keys are held
down by holding down keys like Control, Alt or Shift - the characters shown on each key will
change when you press down the Control key, say.

You should also notice a string of text on the right of the status bar at the bottom of the screen -
this is the name of the keymap that you are currently editing.  If the terminal you are editing
supports multiple keymaps, you can select the particular map that you wish to edit from the Maps
menu - the text in the status bar will change to reflect the new map that you have selected.  Note
that the first map on the menu is usually the standard map for the keyboard, while any other maps
just overide specific sections of the standard map.

Editing a Key

To change what characters are sent during a terminal session when you depress a specific key,
click on that key on the screen, or press the key on the keyboard. A dialog will come up showing
the characters which will be sent out.  Because some of these characters have no visual equivalent
(like the Carriage Return character, which moves to the next line) you can view the codes in three
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different ways - either as normal text,  as control characters (preceded with a caret  (^))  or  as
hexadecimal notation.  Note that if the key has no default map, or is a "standard" key (e.g. the A
key always sends through the letter a or A), this text field will be empty.

As an example, if you often use a system which requires you to type "/help" (followed by a
carriage return) to obtain help, you may want to set up your F1 key to send through that character
sequence.  To do so, simply clink on the F1 button, and type "/help" in the text box. To append
a carriage return, type Ctrl-M, or change the view to hexadecimal and type 0D on the end of the
string (0D is the hexadecimal value for a carriage return).  Now, every time you use this terminal
emulation,  pressing the  F1 key  on your  keyboard will  send through the  correct  sequence  of
characters to obtain help.

Remember that these mappings apply only to the one terminal emulation which you are busy
defining. You should give this emulation a specific name, so that it can be distinguished in the list
of available emulations.

Page 64



5.4 File Transfer Protocols

A Protocol is a set of rules and standards governing communications between computers. Default
protocols have been setup in  WinRamp Lite. If you wish to edit or add new protocol based on
those supplied with  WinRamp Lite, select the  Protocol option from the  Configure menu. The
Protocol Configuration dialog box will  then be displayed, allowing you to modify settings on
certain file transfer protocols. The settings for each are explained below:

5.4.1 Text Transfers

For uploading or downloading/capturing text (not files), the following settings can be customized:

Timeout:
How long to wait for the first character, before aborting the transfer.

Inter-Line Delay:
The period of time to wait between the sending of each line, for the remote system to be ready to
receive another line. The remaining options are generally useful when moving files to and from
non-DOS systems like UNIX.

Strip LF:
Remove the Line Feed character from the transfer stream.

Strip CR:
Remove the Carriage Return character from the data stream.

Add CR before LF:
Add a Carriage Return character before every Line Feed character transmitted in the data stream.

Add LF after CR:
Add a Line Feed character after every Carriage Return character transmitted in the data stream.

5.4.2 Xmodem and its Variations

Xmodem is one of the original PC- to-PC file transfer protocols and is offered by most BBSes
and  online  systems.  It  uses  128-byte  blocks  when  transferring  file,  adding  an  extra  byte  (a
checksum) to each block for error checking, thereby achieving approximately 95% reliability.
Xmodem/CRC (cyclic redundancy check) is a more sophisticated version of Xmodem, in that it
provides improved error-checking. This has the advantage of improved reliability (approximately
99,6%). Xmodem-1k is the same as Xmodem/CRC except that it uses 1024 block sizes instead of
128. It is faster than Xmodem when there is little or no “line noise”, or interference on the phone
line. Ymodem is actually another variation or derivative of X-modem, specifically Xmodem-1K.
It transmits data in 1024-byte (1-KB) blocks or 128-byte blocks. A variation called Ymodem-G
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has no error-checking and is therefore even faster. There are no settings for this protocol or its
derivatives, therefore the Settings button is grayed out if you attempt to edit one of them.

5.4.3 Zmodem

This  public  domain  protocol  is  the  most  popular  file  transfer  protocol  used  in  PC
communications, especially with high-speed modems. Zmodem uses 512- or 1024-byte blocks.
We recommend you use this protocol with WinRamp Lite. ZModem settings are:

Use 16/32 bit CRC:
The ZModem standard allows for the use of 2 octet  or 4 octet error-correction codes. Select
whichever is used by the remote system (usually 32 bit.)

Crash Recovery:
ZModem allows for partially received file transfers to continue from where they stopped. Check
this option if you wish to make use of this feature. If this option is not enabled and you download
the same file more than once, WinRamp Lite saves every copy you download with the first copy
saved with a .000 extension, the second with a .001 extension and so on.

Auto Detect: 
Will ZModem downloads start automatically when the remote system starts sending? You should
only disable this option if you experience numerous false starts of a download.

Error Retries Before Aborting:
Allows you to specify how many errors the Zmodem protocol will allow before aborting during 
an upload or download.

Hangup Modem on Abort:
Gives you the option of sending a hangup string to your modem if the Zmodem upload or 
download aborts due to the numbers of errors exceeding those specified in the Error Retries 
Before Aborting setting.

5.4.4 Kermit

Kermit is primarily used to transfer files from mainframe or mini computers and is unique in that
it  can transfer 8-bit  files  over a 7-bit  data  link.  It  has  the  ability to  use flexible block sizes
although small data blocks are the norm. The checksum technique is used for error checking.
Kermit  can  change  control  characters  to  other  ASCII  characters  to  improve  reliability.  The
transfer options you can set are:

Max Packet Length:
The  maximum  number  of  bytes  that  will  be  sent  per  block  of  data.  Newer  Kermit
implementations may support larger blocks, but there is no automated way of finding out if this is
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possible. 

Pad Count:
How long to delay inbetween packets of data.

Pad Character:
Which character to send on the data stream while time is being wasted between packets.

EOL character:
End of Line character. Which character to use to signify the end of a line.

Control Quote Character:
Which  character  to  "quote"  in  the  data  stream.  This  character  is  generally  known to  cause
problems if sent on the data stream, so alternate methods are employed to transfer data containing
this character.

Repeat Prefix Character:
Signifies that a data character is repeated in the data stream.
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CHAPTER SIX:     WinRamp Lite REFERENCE:  MENU GUIDE

This chapter lists functions of WinRamp Lite, in the order that they appear on the WinRamp Lite
menus, thereby providing a menu-by-menu guide. Note that buttons for every command have
been setup, so you can make your own toolbars consisting of any combination of actions.

6.1 The File Menu

Contains operations applicable to individual files (uploading and downloading) as well the Exit
option, to close WinRamp Lite itself. The commands available under this menu are:

File | Download

Brings up a dialog box allowing you to choose where to place a file you wish to download
(receive  from  the  remote  system),  and  what  the  filename  will  be.  The  file(s)  will  then  be
downloaded using the file transfer protocol you have selected.

File | Upload

This brings up a dialog box where you can choose which files you wish to send to the remote
system. The file(s) will then be uploaded using the file transfer protocol you have selected.

File | Start Capture

Capture all incoming characters to a file, for later reviewing.

File | Stop Capture

Terminate the copying of received characters to a file. This menu option replaces Start Capture,
when that feature has already been activated.

File | Capture Scrollback

Capture incoming characters that are currently stored in the buffer to a file for later reviewing.

Page 68



File | Text Editor

Launch the text editor you have defined under preferences, for viewing file captures, composing
email etc.

File | Dos Prompt

Runs a virtual DOS machine (known as a “Dos Box”). 

File | Exit

Exit WinRamp Lite, leave the modem connected if it is currently connected.

6.2 The Edit Menu

The "Cut & Paste" menu - operations which are to do with text editing and such. Descriptions of 
commands under this menu follow:

Edit | Mark Graphics

Mark out an area on the terminal window to copy to the clipboard as a bitmapped image.

Edit | Mark Text

Mark out an area on the terminal window to copy to the clipboard as text characters.

Edit | Copy

Copy the selected area to the Windows clipboard.

Edit | Paste

Copy the contents of the windows clipboard as keypresses to the remote system.

Edit | Scrollback

Defines whether the scrollback bar is visible on the right of the terminal window. This bar allows
you to move back through data you have previously received. However, if the bar takes up too
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much room, you can switch it off.
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6.3 The Communicate Menu

Provides all the commands you need to initiate and control a communication session(s). Available
commands are:

Communicate | Open Terminal

This  allows  you  to  open  a  terminal  window  directly,  without  prompting  you  for  dialing
information so that you can dial a remote system manually, using the Hayes AT commands (see
Appendix E).

Communicate | Manual Dial

Dial a remote system, where you enter the telephone number and select the terminal emulation
and device you wish to use in order to make the connection.

Communicate | Dialing Directory

Open the Dialing directory, from which you can enter and edit directory entries and dial a remote
system.

Communicate | Hot Dial

Open the Hot Dial window, in which icons representing your favorite online systems can be set
up. Double Clicking one of these icons will cause WinRamp Lite  to begin dialing the system.

Communicate | Command Stack

Open the Command Stack window, which allows you to type in commands and stores these
commands so that they can be executed in the terminal window at a later stage and as many times
as you specify.

Communicate | Hangup

Terminate the current  telephone connection,  using the method specified in the current  device
configuration. (Either drop the DTR line, or send a specific string to the modem, causing it to
drop the telephone line.)
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Communicate | Send Break

Sends  a  break  command  to  the  modem,  which  overrides  coded  communication  thereby
interrupting  the current process. 

Communicate | Half Duplex

Toggle between full  duplex (simultaneous, bi-directional communication) and half-duplex (bi-
directional communication, but only one way at a time).

Communicate | Reset Modem

Allows you to reset the modem using the method specified in the current device settings.

Communicate | Auto Answer

Sets your modem to auto answer mode ( the equivalent of sending an ATA command string to
your modem), for when you wish your PC to act as a host (refer to Tricks and Tips in Appendix
B).

Communicate | Doorway Mode

This option allows the sending of the IBM keyboard scancodes to the remote system. This is
required when using some remote-access programs, and some BBS doors. This allows the remote
system to realize when you have pressed keys like the Alt key, and both Shift keys. This is often
referred to as "Raw Mode", or "IBM keyboard mode".

Communicate | Reset Terminal

This refreshes the terminal, clearing characters under the terminal emulation being used in the
active communications session. The cursor is sent to the top of the terminal window.
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6.4 The Configure Menu

Allows the modification of the environment in which  WinRamp Lite operates, including which
devices  are  available,  which  emulations  are  available,  etc.  Descriptions  of  each  command
available under this menu follow:

Configure | Device

Set up and specify details about devices you have attached to your computer that you may want to
use in a communications session.

Configure | Terminal

Set-up terminal emulations that you may wish to use when connected to a remote system.

Configure | Protocol

Set-up file transfer protocols that you may wish to use when downloading or uploading files to
and from a remote system.

Configure | Preferences

This dialog allows you to change the way WinRamp Lite does certain things, to better conform to
the way you work, and the system you run WinRamp Lite on. 

Configure | Toolbars

Allows you to determine which WinRamp Lite functions appear on which toolbars. You can have
multiple toolbars, with multiple functions on each. Choose your toolbar at the top, or create a new
toolbar. Then, select the functions from the list at the left, to add to that toolbar (listed on the
right). Click OK when you have defined the toolbars as you want them.

Configure | Current Terminal

Allows  you  to  change  the  set-up  of  the  current  terminal  emulation  you  are  using  in  a
communications session.
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Configure | Fine Tune

Allows you to fine tune certain elements of your communications settings, such as baud rate,
parity setting, word length etc. 

6.5 The Scripts Menu

Consists of options related to the recording, running and writing of scripts and macros which
enable you to automate WinRamp Lite.  The options for this menu are:

Scripts | WR-Script AutoLearn

The AutoLearn facility enables you to automate tasks that  you do repeatedly on a BBS, e.g.
logging in, checking mail etc.  Once this option is enabled, all the actions you perform will be
stored in a file which compiles automatically.  Select the option again in order to disable the
AutoLearn facility.

Scripts | Run Script Object

Executes the WR-Script file that you have compiled.  This file can be created using AutoLearn or
the WR-Script IDE.

Scripts | Stop Script

Interrupts the execution of the WR-Script file that is currently running.

Scripts | WR-Script IDE

Launches the WinRamp Lite Integrated Development Environment which enables you to write,
edit, debug and test WR-Script files.

Scripts | Compile Script

Compiles the specified WR-Script file using the WR-Script Compiler.

Scripts | Record a Macro

A macro is a sequence of key presses that can be saved as a <filename>.mac file.  The Record
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Macro option allows you to literally record every action you perform using your keyboard during
an  open  communication  session.   This  sequence  of  actions  can  then  be  executed  whenever
necessary.

Scripts | Playback a Macro

Executes a macro that you have recorded.  When the macro is executed, the recorded sequence of
key presses  are automatically performed at  the speed they were recorded or faster  if  you so
specify.

Scripts | Attach Tool Buttons

Allows you to attach toolbar buttons to any scripts or macros you choose so that they can be
executed at the mere click of a button.

6.6 The Window Menu

Controls the child windows of WinRamp Lite, resizing, closing, etc. Descriptions of these menu
items follow:

Window | Tile

As in all standard Windows applications, this will arrange all child windows of WinRamp Lite so
that they are displayed side by side or above each other, with no windows overlapping.

Window | Cascade

Arranges all child windows of WinRamp Lite that may be open so that they overlap neatly, with
just the left edge and title bar of background windows visible.

Window | Arrange Icons

When one or more child windows of WinRamp Lite are minimized, this menu option will arrange
the minimized windows icons more neatly.

Window | Default Size

This will restore the terminal windows to the default size for the terminal emulation which is
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currently being used.

Page 77



6.7 The  Directory Menu
(only displayed when dialing directory window open)

Provides the various actions you can perform with the dialing directory,  such as maintaining
directories and directory entries, and changing the appearance of the dialing directory window.
Commands available are:

Directory | Dial

Dials the active entry that appears in the Dialing Directory, so that a communications session can
be started. Equivalent to double clicking on the entry itself. 

Directory | Edit

Allows you to modify details about the active entry in the dialing directory.

Directory | Add

Allows you to add a new entry to the active directory, where details about the remote system are
captured for use when dialing.

Directory | Delete

Removes the active directory entry from the dialing directory database.

Directory | New Directory

Allows you to create a new dialing directory, which will appear as a tab at the bottom of the
dialing directory window.

Directory | Delete Directory

Removes the current dialing directory and all associated entry details.

Directory | Directory Tabs

Provides you with the option of having the directory tabs displayed or not displayed at the bottom
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of the dialing directory window. If they are not displayed, others details such as directory entry
comments are displayed instead. 

Directory | Quick Select Tabs

Provides you with the option of displaying or not displaying the alphabetic tabs on the right of the
dialing directory window.

Directory | Toolbar

Allows you to toggle the display of the dialing directory toolbar.

6.8 The Register Menu

Information to assist you in registering WinRamp Lite!

Register | Register WinRamp Lite

Brings  up  the registration form which you fill  in  once  you’ve registered  WinRamp Lite and
received all the benefits that go with registration.

Register | Evaluation Licence

Displays the licence agreement that applies when you use an unregistered copy of WinRamp Lite
for the 30 day evaluation period.

Register | Benefits

Describes the benefits of registering WinRamp Lite.

Register | Special Offer

Provides details on the special introductory offer that applies if you register WinRamp Lite.

6.9 The Help Menu
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Access the Windows Help system, with WinRamp Lite-specific help. Help menu items are:

Help | Contents

The main help file for WinRamp Lite, describing features and functions available.

Help | Search for Help on

Allows you to search for help on a specific topic.

Help | How to Use Help

Help on help - provides details on how to use the Window’s hypertext help system.

Help | How to Guide

A step by step guide to performing each function available with WinRamp Lite.

Help | About WinRamp Lite

Tells you about WinRamp Lite, including credits, version and registration information.
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Appendix A:     GLOSSARY AND ABBREVIATIONS

Abbreviations

ANSI: American National Standards Institute
ASCII: American Standard Code for Information Interchange.
BBS: Bulletin Board System.
BPS: Bits per second. 
CRC: Cyclic Redundancy Checking.
MB: Megabyte - One million bytes.
RAM: Random Access Memory.
RIP: Remote Imaging Protocol.
GIF: CompuServe Graphic Interchange Format.

Glossary

Abort
A procedure to terminate execution of a program.

Application
A program which runs on a computer and performs certain tasks.

ASCII
American Standard Code for Information Interchange. This is a 7-bit information coding system
standard (with an 8th bit often added) It assigns a number (between 0 and 127) to each of the
letters (upper- and lowercase), numbers, control characters and special characters. The eighth bit
is often a calculated parity number (usually even) in communications software.

ASCII Download
ASCII text download governed by XON/XOFF flow control, with no error checking.

Asynchronous
A communications method whereby data is sent in a stream of bits with start and stop bits.

Hayes AT Command Set
A de facto standard for modem control commands, used by Hayes-compatible modems. 

Baud Rate
The actual rate of characters or symbols transmitted per second.

BBS Door
A stand alone program which can be accessed by users of bulletin board systems to perform a
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number of specialized functions.

Page 82



Binary
Computer numbering system that uses  two digits ( 0 and 1) to store and process data.

Bits Per Second (bps)
The number of data bits sent between two modems in one second. Used to indicate a modem’s
speed.

Block
A group  of  characters  (typically  128  or  1024  bytes)  sent  together  (including  error-checking
information) during a file transfer or other communication.

Bulletin Board System (BBS)
A host computer set up to receive calls and allow communication between the user base.

Buffer
A temporary storage area in computer memory for data. Buffers are used by file transfer protocols
to speed the transmission.

Byte
A group of 8 bits of binary digits that the computer considers a unit.

Capture
Storing data being sent by a remote system (BBS or Online System) to a file or buffer for viewing
at a later stage.

Carrier
The basic signal used by modems to transmit data over the phone lines.

Checksum
A method for checking that data is transmitted correctly. 

COM
Specifies a serial communication port, e.g. COM1, COM2, etc.

Cyclic Redundancy Checking (CRC)
A method of data transfer error checking

Data Bits
The bits of data sent by a modem and passed on to the computer.  As a communications setting,
this specifies the number of data bits the modem will use.

Demodulate
Conversion of the modulated carrier tone sent by a modem back into data.
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Device
Any piece of equipment that can be attached to your computer, such as a modem or a printer.
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Download
The process of retrieving data from a remote system. The data (usually a file) being retrieved is
also called the “download”

Error Checking
Checking for errors in data transmission and resending data if any errors are found (see Appendix
C).

Field
A specific unit of information (e.g. name) stored in a database or some other data collection.

File
A group of related data treated as an independent unit containing data, programs, etc.

Flow Control
A method of controlling the flow of data between two devices.

Handshaking
Two devices (modems) involved in a communications connection acknowledging each other and
synchronizing behavior.

Hangup
Terminating a modem connection.

Hardware
The physical part of a computer - often described as "the bits you can kick!"

Hayes-Compatible Modem
The  modem  is  compatible  with  the  industry  standard  Hayes  modems  and  their  Hayes  AT
command set.

Hexadecimal
A base 16 numbering system (0-9 and A-F) used in the computer field.

Host/Remote System
The BBS or online system you connect to during a communications session.

Initialization String
A command/s specifying the set-up the communications program requires to communicate with
the modem.

Kermit
A file  transfer  protocol  designed  for  portability  and  flexibility,  which  compromises  transfer
speeds.
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Keyboard mapping
Defining  which  keys  send  which  codes  to  a  remote  computer.  Used  to  make  one  keyboard
function as a different keyboard.

Page 86



Line Noise
Interference in modem transmission caused by static and disturbances over the telephone line
cause some noise to creep into the transmission, resulting in garbled data being received, or lost
carrier.

Logon
Connecting to and entering your user name and password (if necessary) on a remote system.

Modem
A device for communicating over the telephone line which changes analog to digital (and vice
versa) signals. Stands for MOdulator/DEModulator.

Modulate
Changing a digital signal to analog so that data can be transmitted over the telephone network to
another modem.

Online
When you are connected to a remote system you are said to be “online”. Also refers to the modem
state when it is connected to another modem. 

Online System/Service
A remote system users can connect to and perform a variety of functions,  usually for a fee. 

Multiple Communication Sessions
The ability to connect with two or more remote systems concurrently.

Parity
A form of error checking where the number of bits in every byte is made to be even, or odd by
adding a 1 or 0 bit to each byte. 

Port
The connection between the computer and external devices such as printers or modems.

Protocol
Rules  and  standards  governing  communications  between  computers,  e.g.  error-checking
protocols, file transfer protocols, data compression protocols etc.

S-Register
Storage area in the modem’s memory that contains the modem’s settings.

Scroll
Moving the visual portion of a display horizontally or vertically across the screen.

Serial Communication
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Transmission of data (bit by bit) between two computers or devices/modems.

Serial Port
A connection between the computer and an external device that transmits/receives data one bit at
a time, e.g. COM1

Software
The programs or applications which run on the computer, turning it from a worthless hunk of
metal into a stubborn, irritating computing machine!

Sysop
The remote SYStems OPerator, who runs a BBS or online system.

Synchronous
A communications method whereby data is sent in a continuous stream with constant timing. 

Terminal
The keyboard and screen that you use to interact with a remote system. Your PC acts as a certain
type of terminal during a communications session.

Terminal Emulation
A mode in which your computer acts like a specific type of terminal.

Terminal Window
A mini “screen” which shows what a “real” terminal would show on its screen.

Timeouts
When the transmission of a block of data exceeds the specified time limit, the file transfer is
terminated. 

Toolbar
A group of icons that trigger certain events when clicked on with the mouse. Often contains
shortcut menu access methods.

Upload
The transmission of data (usually a file) from your computer to a host system via the modem.

Window
A box drawn on your computer monitor representing a single application or function.

Xmodem
A simple, widely implemented protocol with basic error-checking.  Variations include Xmodem-
1K (uses 1024-byte blocks instead of 128), Xmodem-CRC (better error-checking) and Ymodem.

XON/XOFF
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A simple means of software flow control used by communications applications.

Ymodem
A file  transfer  protocol  developed  as  an  extension  to  the  Xmodem  protocol,  improvements
include CRC error-checking,  1024-byte  blocks instead of  128,  and  transmission  of  filename,
actual size, and date.
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Zmodem
The most popular file transfer protocol as it has a number of improved features over the other
protocols, e.g. better error-checking and reliability, faster speeds.
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Appendix B:     COMMON PROBLEMS, TIPS & TRICKS

Dialing Problems

If you have dialed a remote system and cannot get a connection, try the following:

· Check the basic equipment: The modem's power supply is switched on, the modem cable is
connected properly, none of the connections are loose, the phone cable is plugged in.

· Dial the phone manually to check it is not faulty.
· If the remote system doesn’t answer, first try again. If there is still no answer, it is likely that

the problem exists with the remote system, or with the telephone line. All you can do in this
case is try again later. The same goes for a busy signal - either the remote system’s modems
are all in use or there is a problem with the telephone network.

· If the remote system sends an answering tone, but there is no response in  WinRamp Lite
check your modem's connections and WinRamp Lite’s settings. Failing this, try your modem
with another connection and application, if it still does not work, then the problem is internal
to your modem.

File Transfer Problems

There are a number of reasons for a file transfer failing or giving you problems. Some of the most
common can be avoided by:

· Ensuring your modem is connected properly.
· Ensuring the communications parameters for the remote system have been set-up correctly.
· Avoiding downloading or uploading files if  there is  bad line noise.  Rather wait  until  the

connection is clear, i.e. when you are not getting garbled characters appearing on your screen.
· Selecting the proper file transfer protocol - we recommend Zmodem if the remote system

supports  it.  Experiment  with  protocol  settings  (remote  systems may implement  protocols
slightly differently). If you have selected the wrong protocol, abort the current file transfer by
pressing Ctrl-x a few times, and then select the correct one.

· Wait a few seconds before aborting a file transfer, the system may just be correcting a bad
transmission block.

· If you have problems using the ASCII data capture feature or upload, note that this protocol is
for 7-bit text files only (not binary files).

· Check that the directory and file name were typed in correctly.
· Remember  that  most  files  you  transfer  will  be  compressed  -  you  therefore  need  the

appropriate decompression utility software before you can use the file.

Disconnections
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If you are abruptly disconnected, it may be for one of the following reasons:;
· Bad line noise.

Page 92



· The phone line you are using is interrupted.
· The modem is attempting MNP5 communication but the remote system only handles MNP4.
· You have exceeded the online system’s inactivity time period, and it automatically logs you

off.

General Communications Problems

A  number  of  communications  problems  may  be  caused  by  mismatched  communications
parameters,  for instance: connecting to a remote system and being immediately disconnected;
connecting then getting garbled characters scrolling off your screen, connecting then getting no
response. To remedy these problems, try dropping to a lower modem speed (e.g. from 9600 to
2400 BPS). Try changing the data bits/parity/stop-bit setting to 8/N/1 or 7/E/1.

If you get garbled characters appearing on your screen where normal words should appear, check
that  the  remote system supports  the  terminal  emulation you have chosen and that  the  parity
setting is correct.

If the screen goes “dead” , i.e. what you type does not appear on the screen and the remote system
is not responding, it may be because the pause signal (Ctrl-S) has been inadvertently entered. Use
Ctrl-Q to remove the pause. Sometimes when using the ANSI terminal emulation, the terminal
window may freeze. This is due to a conflict with the codes used for Start ANSI Music and Delete
Line. Clicking Reset Terminal from the Communicate menu should correct this problem.

If the screen comes out with blank lines between each line of text, this is because the text is
wrapping from one line to the next, and the remote system is still sending a Carriage Return to
move to the next line. From the Configure Menu, choose Current Terminal, and switch on the
VT100 wrap option.

Tips And Tricks

The following suggestions may help you save time and work more efficiently online.

Reducing online time & therefore charges:

· Most online systems have a guide or manual that can be downloaded. Reading this off-line
can save you time learning the system online.

· Check the online system does not charge for using a faster modem - if it does, weigh-up the
cost of quicker file transfers and screen captures versus this extra levy.

· Use an off-line  mail  reader  to  compose and read messages,  rather  than doing so online.
Alternatively, use the screen capture facility to capture messages to a file, and read them off-
line. 

· Check if the remote system offers speed commands to get you directly to the area or service
you are interested in, rather than navigating through menus.
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Using WinRamp Lite  to transfer files between two local computers

This can be achieved with what is known as a Null-Modem cable. These are usually available in
stores, or you can make your own. Follow the wiring diagram below. You need to plug the cable
into the serial ports of both machines (which are usually male, 25 pin D Plugs, or occasionally
male, 9 pin D plugs).  If you are unsure, ask your hardware supplier which ports are which. You
then need to run  WinRamp Lite on each machine, and open a terminal session using a device
which uses that serial port (COM1, COM2, etc.). Your best bet is to set up a device referring to
that port, using hardware flow control. Once connected, open a terminal session using that device,
and without  specifying a telephone number.  Then anything you type on one machine should
appear in the terminal window on the other machine. You can then do uploads and downloads as
though you were connected to an online system. To transfer a file from machine A to machine B,
choose  upload  on  machine  A,  select  the  file  (or  files)  you wish  to  transfer,  and  choose  the
ZModem  protocol.  Once  you  start  the  transfer,  machine  B  should   automatically  start
downloading (only if you used ZModem, though.)

Null Modem cable connection diagram :

   DB25 FEMALE 2   3  4  5  6     7  8  20  1
               |   |  |  |  |     |  |  |   |
               |   |  |  |  |     |  +--+   |
               |   |  |  |  |     |  |  |   |
   DB9  FEMALE 3   2  7  8  6     5  4  1   |
               |   |  |  |  |     |  |      |
               |   |  |  |  |     |  |      |
               |   |  |  |  |     |  |      |
               |   |  |  |  |     |  |      |
               |   |  |  |  |     |  |      |
  DB9 FEMALE   2   3  8  7  4  1  5  6      |
               |   |  |  |  |  |  |  |      |
               |   |  |  |  +--+  |  |      |
               |   |  |  |  |  |  |  |      |
  DB25 FEMALE  3   2  5  4  20 8  7  6      1
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Appendix C:     ERROR CHECKING PROTOCOLS

Modem error checking resends data until it is transmitted error-free (or until a timeout is reached
in  which  case  the  transmission  is  aborted),  assuming  both  modems  support  the  same  error-
checking protocol. Some of the error-checking terminology is explained below:

ARQ
Automatic Request for Repeat mimics MNP, LAPM and other binary file-transfer protocols. Used
by USRobotics and some Hayes V series modems.

MNP
Microcom networking protocol is a proprietary error-correction and file-compression protocol,
usually found on the modem’s ROM chips. There are 9 levels/classes:

MNP1: For asynchronous communications, half duplex.
MNP2: For asynchronous communications, full duplex. 
MNP3: For synchronous communications, full duplex.
MNP4: For  synchronous  or  asynchronous  communications,  providing  automatic  error
correction.
MNP5: The same kind of error correction and packet sizing as with MNP4, but including data
compression.
MNP6, 7, 9:  MNP levels 6, 7, and 9 are similar to MNP5, but have better data compression
and error correction. Used with V.32 modems. 

MNP4 and 5 are used most often with dial-up communications.

LAPM
Link Access Procedure for Modems is a protocol that provides error control between two V.42
modems supporting the protocol.
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Appendix D:     MODEM MODULATION & DATA COMPRESSION
PROTOCOLS

Modulation Standards

For two modems to connect and communicate, they must both be using the same modulation
technique. Common techniques are:

V22: 1200 BPS, asynchronous.
V.22 bis: 2400 BPS, synchronous and asynchronous, full duplex.
V.29: 4800/7200/9600 BPS, synchronous, full duplex.
V.32: 4800/9600 BPS, synchronous and asynchronous, full duplex.
V.32 bis: 4800/7200/9600/12000/14400 BPS, synchronous and asynchronous, full duplex.
V.42: Error  control  standard  (part  of  the  V.x  standard,  although  not  a  modulation
technique).
V.42bis: Data compression standard (part of the V.x standard, although not a modulation
technique).
V.FAST: upto 19200 BPS.

Data compression protocols

When  a  modem  standard  end  with  “bis”,  this  implies  it  supports  data-compression.  Data
compression  is  typically  implemented  by  eliminating  repeated  or  redundant  characters/bytes,
although some modems use other methods (e.g. USRobotics HSTs). Data compression means a
V.42 bis modem should support a throughput of up to four times its transmission speed, e.g. a
9600 bps modem can have a throughput of 38,400 bps while transmitting at 9600 bps.

For details on which modem modulation and data compression standards your modem support,
refer to your modem manual.
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Appendix E:     BASIC Hayes AT COMMAND SET

The most common modem commands are defined by the "AT" or "Hayes" command set. Typical
Hayes  AT commands  used  (excluding  the  extended  Hayes  AT commands)  are  (more  details
should appear in your modem manual):

+++ Switches the modem to command mode, acting as an escape key when you are online.

ATO Switches you from command mode to online mode.

A/ Repeats the most recent command

^C or ^K Closes the modem's help screen.

^S Pauses display of information when the modem is in command mode (flow control)

^Q Resume the display of information when the modem is in command mode.

AT Initializes the modem, clears the command buffers and precedes most commands.

ATA Puts modem into answer mode in order to answer an incoming call manually.

ATC1 Turns the modem’s transmitter on (the default)

ATC0 Turns the modem’s transmitter off, for receive-only mode.

ATDP <options; phone number> Dial the specified phone number using Pulse dialing.

ATDT <options;phone number> Dial  the  specifies  phone  number  using  tone  dialing.
Options are (for pulse dialing too):
, Pause for two seconds
; Dial then change to command mode
" Dial the letters that follow as numbers (useful for 1800 number)
@ Wait for an answer (does not "time out" after a certain number of rings)
! Transfer call
/ Pause for 1/8 second
R When receiving modem cannot answer incoming calls
W Wait for second dial tone

ATDS Dial a number stored in the modem's memory (if modem supports it)

ATE1 Turns command-mode character echo on (used for manual dialing)
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ATE0 Turns command-mode character echo off (the default).

ATF0 Turns local echo on for half duplex, used when remote system is operating at full duplex. 

ATF1 Turns local echo off (the default).

ATH0 To hang up or disconnect the phone line hangs 
ATH1 To open the phone line

ATI <command option> Returns information depending on the option:
AT10-7 Displays information about the modem and its settings.
ATI0 Displays the product code or current speed setting
ATI1 Starts ROM test
ATI2 Starts RAM test
ATI3 Displays call duration or the current time
ATI4 Displays current settings
ATI5 Displays NRAM (nonvolatile RAM) settings
ATI6 Displays link diagnostics
ATI7 Displays a product configuration

ATK0 Makes the AT13 command display current call duration

ATK1 Makes the AT13 command display the current time.

ATM0 Turns the modem’s the speaker off.  

ATM1 Turns the modem’s speaker on until carrier detected (the default)

ATM2 Turns the modem’s speaker on so it remains on at all times.

ATM3 Turns the modem’s speaker on after the modem receives a dial string and off when carrier
is detected.

ATP Sets the modem’s dial mode to pulse (the default).

ATQ0 Turns on the display of call result codes (the default).

ATQ1 Turns off the display of call result codes.

ATSr Displays specified S-register r’s settings.

ATSr=nn Sets  the  value  of  the  S-register  r  to  nn,  so  that  settings  can  be  customized,
assuming your modem supports this.
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ATT Sets the modem’s dial mode to tone.

ATV0 For result codes to be displayed as numbers.

ATV1 For the result codes to be displayed as letters (the default).
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ATX <number from 1 to 7> For display of  result  codes  and various features  depending on
your modem brand.

ATY0 Stops the modem's response to a Break signal (the default)

ATY1 Ensures modem will disconnect with a Break signal.

ATZ Resets the modem to its currently stored default.

AT& Prefix for extended Hayes AT command set.

AT$ If modem has online help, provides summary of extended commands. 

AT&$ If modem has online help, provides summary of extended command set and options.

ATD$ If modem has online help, provides a summary of available dial commands.

ATS$ If a modem has registers that can be set, provides a summary of those available.
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Appendix F:     CONNECTION RESULT CODES

The status of a connection can be determined once you’ve dialed a remote system. A description
of the result codes you may see follow (for details, consult your modem manual):

BUSY Modem has made the call but has detected a busy signal and therefore disconnected. 
CONNECT 300 bps connection
CONNECT 1200 1200 bps connection
CONNECT 2400 2400 bps connection
CONNECT 4800 4800 bps connection
CONNECT 9600 9600 bps connection
CONNECT 300/REL 300 bps connection with error checking
CONNECT 1200/REL 1200 bps connection with error checking
CONNECT 2400/REL 2400 bps connection with error checking
CONNECT 4800/REL 4800 bps connection with error checking
CONNECT 9600/REL 9600 bps connection with error checking
ERROR When you enter a command that is not allowed
NO ANSWER Displayed  after  the  pre-set  number  of  rings

before disconnecting
NO CARRIER When the remote system disconnects or the carrier is lost.
NO DIALTONE When the modem gets no dial tone when trying to make a call.
OK Displayed after you enter a command and it is implemented.
RING/RINGING Displayed each time the phone you are attempting to dial rings
VOICE Displayed  when  the  modem  detects  voice

answering  instead  of  another  modem,  after  which  it  will
disconnect.
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Appendix G:     TERMINAL IMPLEMENTATION NOTES

TTY:

TTY is a very simple terminal emulation which supports nothing but the standard ASCII control
codes:  carriage  return,  line  feed,  backspace,  bell,  tab  (every  eighth  column),  vertical  tab
(implemented the same as line feed), and form feed (clear screen). The delete character and any
other C0 control characters are ignored.

If you are using an 8-bit connection, any characters greater than 127 will be displayed using the
IBM-PC character set.

There is no default keymap for the TTY terminal. It will send through standard alphanumeric
characters,  and  certain  control  characters,  but  none  of  the  function  keys  or  arrow  keys  do
anything.

ANSI:

This terminal is based on the ANSI X3.64 standard with a couple of extensions from VT100 (e.g.
scrolling regions),  and support  for colors as implemented by the MS-DOS ANSI.SYS driver.
Since there isn't an official specification for ANSI as implemented by Bulletin Board Systems,
this implementation includes just about every ANSI command available in an attempt to be as
compatible as possible.

Character set mapping is supported for the ASCII, UK and Special Graphic character sets, but the
terminal is treated as a 7-bit system, so you can only map into GL (characters 32-126). Any 8-bit
characters (greater than 127) are displayed using the IBM-PC character set.

The default keymap for ANSI sets up the arrow keys to send the ANSI escape sequences for up,
down, left and right. The Home key sends the escape sequence for moving the cursor to the home
position, and the End key sends the sequence for clearing to the end of line.

Avatar:

Avatar  stands  for  Advanced  Video  Attribute  Assembler  and  Recreator.  It  was  designed  as  a
replacement for ANSI on Bulletin Boards, and uses binary codes which make it  considerably
faster. 

There are two levels of Avatar - a full session (which includes a number of advanced features),
and a basic session (which includes just the basic codes for manipulating the display).
WinRamp Lite currently supports only the basic session (also called AVT/0+). This is actually an

Page 102



slight  extension  of  the  original  level  0  specification  (AVT/0),  which  has  long since  become
obsolete.

Although Avatar uses the Doorway Mode keyboard, it is possible to map the keys to your 
specification.

VT52:

This is an implementaion of the DEC VT52 terminal. Unlike the later VT terminals, the escape
sequences  used  by  VT52  don't  comply  with  the  ANSI  specifications,  but  are  slighty  faster.
However, VT52 isn't particularly powerful and has a minimal set of commands.

VT52 is a 7-bit terminal, and so will reset the most significicant bit of any incoming 8-bit data so
that it fits into 7-bits. Other than the standard ASCII character set, VT52 also supports a graphic
character set which can be mapped into characters 95 to 126.

There are two default keymaps that come with VT52 - a standard keymap which maps the VT52
keypad function keys (F1 to F4), the cursor keys, and the numeric keypad; and a second keymap
which  overides  the  numeric  keypad on  the  standard  keymap to  send through special  escape
sequences instead of numbers when the Keypad Application Mode is enabled.

VT100:

This emulation is based on the specification for the C. Itoh CIT-101 terminal (which is supposed
to  be  fully  compatible  with  the  DEC  VT100  terminal).  All  VT100  commands  have  been
implemented except  for the Auxiliary Port  commands (which don't  really apply),  the Double
Height and Double Width commands, and a few other minor features which shouldn't really effect
the usability of the terminal (smooth scroll, keyboard auto repeat, time commands, and a couple
of CIT specific commands). 

A number of commands from the DEC VT320 specification (it describes VT100 commands as
well) that weren't mentioned in the CIT-101 specification were also implemented. This includes
the Insert Character command, which apparently isn't supported by the VT102 terminal, but is
supported by certain other VT100 "clones".

Character set mapping is supported in the same way as the ANSI terminal. Only the ASCII, UK
and Graphic character sets are supported - the Alternate and Alternate Graphic character sets map
to ASCII as well. Unlike ANSI though, any 8-bit characters greater than 127 have their most
significant bit reset since VT100 is meant to be a 7-bit terminal.

VT100 comes with five  default  keymaps -  a  standard keymap that  maps the VT100 keypad
function keys (F1 to F4), the numeric keypad, and the cursor keys; a keymap that remaps the
cursor keys for when the terminal has Cursor Key Application Mode enabled (they send through
different escape sequences); a keymap that remaps the numeric keypad for when the terminal has
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Keypad Application Mode enabled (similar  to  the  way VT52 works);  and both of  the  VT52
keymaps, for when VT100 is emulating VT52.

VT220:

This is a partial implementation of the DEC VT220 terminal. It is based on the DEC VT320
specification (so it may implement a couple of VT320-specific commands), but a couple of the
more esoteric features of VT220 have been left out. It doesn't support dynamically redefinable
character  sets,  user-defined keys,  and some of the status report  commands.  It  does,  however,
support the International Model's Character Set Mode command, but it doesn't support the Data
Processing mode for international keyboards.

VT220  implements  ASCII,  DEC Supplemental,  ISO Latin-1  Supplemental  (this  is  a  VT320
character set, but has been included anyway), and DEC Special Graphic character sets. When the
Internation  Model  Character  Set  Mode  is  enabled,  you  can  also  map  in  the  12  different
international character sets. Also, since it is an 8-bit terminal, you can map character sets into
both the GL (characters 32 to 126) and GR (characters 180 to 255) sets.

VT220 comes  with  five  default  keymaps  much like  VT100  but  with  a  few more  keys.  The
standard keymap includes mappings for the VT220 normal function keys (VT220's F6 to F12 are
mapped to the PC's F6 to F12 keys, and F13 to F20 are mapped to Shift-F3 to Shift-F10). It also
includes mappings for the VT220 editing keypad (Insert and Remove map to Insert and Delete on
the PC's dark gray keypad; Find and Select map to Home and End; and Prev Screen and Next
Screen map to PageUp and PageDown). The rest of the keys on the standard keyboard are the
same as the VT100 keys, as are the other four keymaps.

Prestel:

This emulation is based on the description of Prestel provided in the South African BELTEL
Terminal  Specification.  Prestel  is  a  simple  protocol  with  colour  support,  a  few basic  cursor
control functions, and a couple of character attributes commands (double height and flashing).

It is a 7-bit protocol with a character set that is slightly different from ASCII. However, it also
support a 2x3 mosaic character set which can be used to produce simple low-res graphics. The
font itself is wider than most terminal fonts, since Prestle uses only 40 columns.

Prestel comes with one default keymap which changes certain keys on the PC keyboard so that
they map to corresponding characters in the Prestel character set. It also provides control key
mappings for Prestel characters not found on the PC keyboard (Ctrl-1, Ctrl-2, Ctrl-3, Ctrl-4 and
Ctrl-5 produce 1/4, 1/2, 3/4, the pound sign and the divide sign; Ctrl-LeftArrow, Ctrl-RightArrow
and Ctrl-UpArrow produce the left, right and up arrow characters).

The numeric keypad always produces digits, and the foward slash key on the keypad produces a

Page 104



hash (so as to be more like a telephone keypad). The dark gray arrow keys produce the prestel
control characters for up, down, left and right movement.

RIPScrip:

This is an implementation of the 1.54 revision of the RIPScrip specification. RIPScrip stands for 
Remote Imaging Protocol Script language - it is a text based script language for displaying online 
graphics and was designed specifically for the BBS community. In an effort to remain compatible
with existing BBS software and allow for partial RIP support, the specification also supports 
ANSI sequences mixed in with the RIPScrip graphics commands. 

However, since RIPScrip has its own set of fonts, it does not support character set mapping like 
ANSI - the IBM-PC character set is always used.

There are two default keymaps provided with RIPScrip - the first one is the same as the standard 
ANSI keymap; the second one is used when the VT102 keyboard mode is enabled - mappings are
provided for all the function keys, the PageUp, PageDown and Insert keys, and the mapping for 
the End key is changed.
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Appendix H:     WINRAMP LITE REVISION HISTORY

WinRamp Lite Version 1.2: released 14th October 1994

1.  Changed max scrollback buffer size to 9999 (was 999).

2.  Open Terminal Emulation windows now appear in the main Window menu.

3.  Added 3-D "look" to Checkbox and Radio buttons in the Custom Control library, now 
renamed to VCTRL.DLL

4.  Global Preferences accepts full DOS path to text editor.
  
5.  Alt+<key> accelerator beep fixed.

6.  Fixed deleteing partial files option ( see transfer.dll )
  
7.  Accelerators in Manual Dial dialog fixed

8.  Dialing "Cancel" bug fixed

9.  Added "Auto Horizontal" scrolling to various edit controls

10. Tool tip delay/scroll back lines arrow control fixed.

11. Dialing Directory. Fixed bug causing occasional "Division by Zero" error.

12. Fixed column sizes in dialing dirrectory to 'remember' what the percentages were.

13. Added a "Confirm to Exit" option in Global Preferences. Implemented this option.

14. Fixed problem preventing exiting of WinRamp after selecting "Cancel" in "Hangup Modem?"
dialog.

15. Fixed GP caused by terminal (RIP emulation) inducing a file transfer.

16. Added keystroke control to the tabs used in dialing directory and preferences.
  
17. Changed Ctrl-<key> accelerators that could conflict with well known applications to Ctrl-
Shift-<key> accelerators.

18. Changes for script passthrough mode switching.
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19. Fixed incorrect enabling/disabling of toolbar buttons.

20. Fixed bug caused by deleting a macro/script button whilst on a custom toolbar that occured 
during script/macro custom button creation and editing.

21. Script/Macro buttons getting greyed when editored and terminal is open - fixed
  
22. Corrected various problems that caused "session detected" error message.
  
23. Fixed bug of dialing after "Skip" not cancelling properly.

24. New global settings dialog format with a number of additional setting options.
  
25. Fixed problem with Dialing Directory that occured when selecting an entry with the Right 
mouse button.
                                                                                   
26. Fixed Page Up/Down problem in Dialing Directory.
  
27. Fix dialing directory error causing loss of entries when a large number of entries where added.

28. Added "Command Stack" buffering feature. (Press Alt-Y to use).

29. Added support for long numbers in Dialing Directory and manual dial. Added support for 
letters in dialing directory number (for use by COMt to "dial" Internet addresses)

30. Fixed problem causing the appearance of a "garbled"  Volume Label if there was no volume 
label.

31. Fixed bug in RIP which caused display problems with certain XOR operations.

32. Fixed bug in Script "Escape sequence filtering" mode.

33. Converted all WinRamp Fonts from version 3 fonts to version 2 fonts.  Some graphics drivers 
didn't support the newer version 3 fonts.

34. Improved font default size selection : any size greater than 800x600 now defaults to the 18x9 
font.

35. Added ability to display characters below ASCII 32 (' ').

36. Added CR and LF insertion capabilities.

37. Process WM_PALETTECHANGED and WM_QUERYNEWPALETTE message to cope    
with colours on a restore.
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38. Avatar bug fix : Made Avatar's codebuf a BYTE array instead of a char array - certain Avatar 
codes were not being typecast correctly.

39. ANSI bug fix : Needed to select a palette out of a DC before deleting the palette.

40. ANSI State fix : ANSI music escape seq didn't work because it contained characters below 32,
which are normally ignored.

41. ANSI bug fix : ANSI attribute 7 could cause hanging, fixed.

42. RIP bug : error in colour mapping routine, didn't always fetch the correct colour.

43. Added support for VT100 double height characters.

44. Made Colour-Flashing a global option since it affects all terminal emulations.

45. Updated VT-52/VT-100/VT-220 keyboard maps (control keys)

46. AVATAR now uses a keymap instead of relying on doorway mode.

47. The aspect ratio used by RIP for drawing circles has been changed from 3/4 to 31/40 so as to 
be more compatible with RipTerm.

48. A GIF viewer has been added for X, Y and ZModem protocols.  The configurable option 
autostarts when a GIF download is detected. The GIF viewer includes scaling and scrolling of the 
image to make viewing easier.

49. ZModem error recovery has been enhanced using a delay to allow the buffer to fill with more 
meningful data.

WinRamp Lite Version 1.11: released 5th September 1994

Corrected font bugs occuring in high resolution graphics modes, namely underline fonts in ANSI 
and half-height RIP fonts.

WinRamp Lite Version 1.1: released 14th August 1994

Modifications, Additions  and Corrections in the Terminals module

1. Three new terminal emulations have been added: VT52, VT100 and VT220.

2. Font handling has been redone to support multiple character sets. 
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3. C0 control characters and the Delete character are now ignored if the terminal doesn't support 
them.

4. Font mapping has been implemented more accurately in the ANSI terminal (proper character 
sets). The SI/SO control characters are   also supported to access the GR and GL character sets.

5. There was a bug in the Rip Text Window command which sometimes caused the cursor to 
disappear when the window size changed. In most terminals, the cursor was the wrong size 
when the 9x18 font was selected.

6. The ANSI parsing system was redone to comply with the ANSI specifications more accurately.

7. Support was added for C0 control character within an escape sequence, as well as the ability to 
cancel an escape sequence with the ESC, CAN and SUB controls characters. Any invalid 
characters in an escape sequence are now ignored.

8. An ANSI sequence that required multiple parameters that had more than one semicolon 
inbetween parameters, or whose parameter ist started with a semicolon would previously have 
failed.

9. Fixed a bug in the backscroll mode which sometimes caused problems with flashing characters 
and the cursor. If you disabled the Colour Flashing option when you were in backscroll mode, 
it would be reenabled again the moment you left the backscroll.

10. When the ANSI scrolling region changes, the cursor is meant to move to the home position, 
which it now does.

11. A scrolling region of (0;0) is meant to set the scrolling region to the full screen. Previously it 
would have set the scrolling region    to be the top line.

12. The ANSI inverse command has been changed to match the way most other packages 
implement it, since it was not working with BBSs that used the command in strange ways.

13. Support for multiple parameters has been added to a number of ANSI commands - these 
commands normally only receive one parameter, but in the event that they did receive more, 
they wouldn't have worked.

14. ANSI commands that take multiple parameters would fail if not all of the parameters were 
specified - they now use default values for any missing parameters.

15. The RIPScrip terminal would sometimes have its palette messed up if another application was
started that tried to change the Windows palette. WinRamp should now restore the palette 
properly when it regains focus, although it may be necessary to shut down the other 
application first.
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16. Fixed a bug in the way RIPScrip returned its identification string, which may have meant that 
certain systems wouldn't be able to detect that you were using RIP.

17. Fixed a bug in the way RIPScrip parsed incoming data which sometimes caused problems 
when ANSI and RIPScrip sequences were mixed together.

18. The ANSI command for deleting all tab stops could sometimes cause the system to GP later.

19. The reset terminal operation now resets all terminal settings back to their defaults (e.g. default
colours, windows sizes, etc).

   Before, it used to just clear the screen and make a few other minor changes.

20. Support for multiple keyboard maps has been added, so that terminals that have keyboards 
that send through different sequences when in different modes (e.g. the VT terminals), can 
have all the keys editable from the keyboard mapper.

21. There was a subtle bug in the RIPScrip Mouse Region command so that mouse clicks were 
sometimes not detected. When mouse regions were saved in RIPScrip, they were restored in 
the wrong order, which would have caused systems that had overlapping mouse regions to 
function incorrectly.

22. The RIPScrip Block Mode command wouldn't process multiple file downloads properly. It 
also sometimes used the wrong directory for    uploads and downloads.

23. The ANSI Insert Line and Delete Line commands have been modified so that they now only 
effect the  area of the screen within the current margins.

24. When there were two sections of flashing text on the same line, seperated by a section of text 
that wasn't flashing, the second    flashing section of text wouldn't flash properly. When 
changes are made to any of the global settings, they now take effect    immediately.

25. Scrollback support added to Prestel.

26. Prestel Fast Mark set to Text by default.

27. The Prestel default keymap was changed so that the numeric keypad sends through numbers 
all the time.

28. Scrollback sometimes caused problems if there was incoming data from the modem while you
were in  the back scroll.

29. Second click when marking text has become configurable - disable, mark word, paste, or 
mark word &  paste.
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30. When marking words, anything outside the range 33-126 is considered a seperator as well as 
comma and semicolon.

31. Support for "quoted" pasting has been added. 

32. The Device Attribute and Printer Port reports were added to the ANSI terminal.

Modifications, Additions  and Corrections in the Keyboard Mapping module

1.  Modified to allow for multiple maps per terminal type.

2.  Menu options included to choose between different keyboard map settings.

3.  New button on toolbar to toggle between keyboard mappings.  

4.  New "Save Message" box when switching beween keymap editing sessions.

Modifications, Additions  and Corrections in the File Transfer Module

1.  When Crash Recovery option is  NOT chosen ZModem will  automatically rename the file
received with an extension of .00x where x increases until there is no file of that name.

WinRamp Lite Version 1.01: released 25th July 1994

1.  RIPScrip emulation has been dramatically speeded up by making a change to the way the 
"Flood Fill" command is handled under Windows.

2.  A fix to the Text Scrolling under all text-based terminal emulations (TTY, ANSI and Avatar) 
has resulted in a major increase in the speed at which incoming text is painted.

3.  Fixed bug that caused Scroll-Back to turn on ANSI "Color Flashing" option.

4.  RIPScrip emaultion "Fast Output" option. Fixed possible cause of GPF error. If an error occurs
under RIP emulation with the "Fast Output" mode option ON, the user will now be given the 
option to switch back to "Slow Output mode".

5.  Fixed RIPscrip Graphics Cut and Copy.

6.  Added support for * character in number dial string. This will allow users to disable Call 
Waiting feature where applicable.

7.  Improved Zmodem download and upload "engine". Numerous tests have shown compressed 
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file transfer speeds of 1560cps are now possible.

8.  Fixed Zmodem "Crash Recovery" Download Resume bug.

9.  Added two options to Zmodem Protocol Settings:
   a.  Configure number of Error Retries before aborting.
   b.  Option to hangup session if file transfer is aborted due to too many errors.

10. Fixed bug causing Windows Alt-Tab application switching to fail after clicking on Toolbar 
button.

11. Changed RipScrip "Fast Output" default setting to OFF.  Please note that if you do NOT have 
graphics accelerator card, and are using the standard VGA graphics driver it is best to switch this 
setting to ON. 

WinRamp Lite Version 1.00b: released 1st July 1994
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